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Follow Along Workbooks
If you want to work along the exercises in this lesson (I strongly recommend
this), please go to my website and download the follow-along workbooks. My
website is:
 
http://markmoorebooks.com/power-pack-bundle/
 
The follow along workbooks you will get in your email contain files for all
the lessons in this bundle. Each lesson has its own .zip file to help you
manage all the files.
 
A bit of clarification on how to get the follow-along workbooks. You will
input your name and email address. You will receive a confirmation email.
Once you confirm, you will receive a second email with the follow-along
workbook.
 
Why do I do this?
 
I can’t package an Excel file with an eBook; Amazon will not allow it. Also,
the only thing I do with your email is send you the workbook and periodically
send you updates about new lessons that I am working on.

Introduction
 
Welcome to another Mastering Excel lesson. If you have completed previous
lessons, thanks for sticking around. If you are new, I hope you enjoy the lesson.
The lessons are easy going, relaxed, no-nonsense, and easy to understand. I try
my best to explain complex topics in a simple and entertaining way. My goal is
that you will finish reading each lesson and have immediately-applicable skills
you can use at work or home.
 
This lesson will focus on an almost unknown feature that Microsoft packaged
in Excel: Power Query. Power Query is pretty awesome. It gives you several
tools that you can use to audit and analyze your workbooks. If you find yourself

http://markmoorebooks.com/power-pack-bundle/


constantly trying to figure out how other peoples’ Excel files work or what they
changed or anything like that, this will be right up your alley. It’s the kind of
thing that once you see it, you’ll wonder how you ever lived without it.
 
 
 



What is Power Query?
Microsoft is taking Excel in a new direction. Microsoft has included in Excel
some very powerful tools to help users analyze large volumes of data. This
analysis is usually called Business Intelligence (BI). Previously, processing
and working with these large data sets was limited to experienced technical
professionals who used expensive software packages. Microsoft wants to do
away with that. They want to bring BI to the average user. They use the term
‘Self Service Business Intelligence’ to indicate that users can now perform this
analysis without calling in their IT departments or external consultants.
 
Microsoft’s toolset is called the Excel BI toolkit. It has several different tools:
 

Power Query - Used to import data
PowerPivot - Used to analyze data
Power View - Used to create presentations
Power Map - Used to create geographical presentations

 
This lesson will start with Power Query. Later lessons will continue with the
rest of the Excel BI toolkit.
 
Power Query
This lesson will focus on how to use Power Query to connect to external data
sources and manipulate the data so you can use it in Excel. Once the data is in
Excel you can build dashboards from it, use it in a Pivot Table, or load it into
the other Excel BI tools to create some spectacular presentations.
 
I want to mention one minor item that more advanced Excel users might be
confused about. What about MSQuery? MSQuery is a tool that also comes with
Excel. I have a lesson specifically on MS Query. MS Query connects to a data
source and returns the data into Excel. In that respect it functions identically as
Power Query.
 
However, Power Query can do much more. Power Query can connect to
multiple data sources, join them together and put them into one spreadsheet.
Power Query can also perform joins, exclusions, and manipulate the data



before it even gets to Excel.
 
For example, suppose you routinely connect to your sales database and extract
the sales data for the current month. With MS Query you will return the data
and then work in Excel to split out the full name files into First, Last, Middle.
You also have to write several formulas to fix any errors or missing data. You
will repeat this process every month. Of course, the more data cleaning you
have to do, the more tedious the task is.
 
Power Query can do all of this data cleaning and manipulation for you. You
can set up your data cleaning process so that it executes before the data gets
loaded into Excel.
 
Power BI
You might hear the term Power BI as you learn about Excel BI Toolkit. Power
BI is part of SharePoint Online. With Power BI, you can share all the analysis
you have performed in Excel with users across your organization. Users can
apply filters to the data so they can see only what they need to see.
Another BI related term you will come across is ETL. ETL is an acronym for
Extract, Transform and Load. This is the process of connecting to the data
(Extract), shape the data into a more functional form (Transform). It can then be
loaded into Excel or another presentation tool like Power View or Power Map
(Load).
 
Data Destination
There are two places into which you can load the Power Query data: Excel or
the Excel Data Model. If you load the data into Excel, it will appear as a data
table that can be refreshed (it will re-connect to the source and retrieve new
data). If the rows do not fit into an Excel worksheet, then you load it into the
Data Model and you can use Power Pivot on the data. Power Pivot will be
covered in the next lesson.

Installing Power Query
Excel 2016
Power Query comes installed in this version of Excel. Power Query can be
found in the Data tab, in the Get & Transform section.
 



Previous Versions of Excel
Unfortunately, not all previous versions of Excel can run Power Query. You
must have one of the following versions:

Microsoft Office 2010 Professional Plus with Software Assurance
Microsoft Office 2013 Professional Plus - All features are supported
Microsoft Office 365 ProPlus - All features are supported
Microsoft Excel 2013 Standalone version - All features are supported
All other Office 2013 versions will have most of the Power Query
features available. Some data connections will not be supported. I will
not be using these connections in this lesson.

 
Internet Explorer - Your PC must have Internet Explorer 9 or later to use
Power Query.
 
You can download Power Query directly from Microsoft at:
https://www.microsoft.com/en-us/download/details.aspx?id=39379
 
Note that when you expand the Details section, you must download the correct
version for your PC. If you have a 64-bit machine, you need to download the
64-bit version of Power Query. A 32-bit computer needs the 32-bit Power
Query version.
 

 
To install Power Query:
 

1. Download the appropriate msi file.

https://www.microsoft.com/en-us/download/details.aspx?id=39379


2. Close Excel.
3. Double click the downloaded file to open it.
4. Follow the prompts.

 
After installing Power Query, you will see a new tab in Excel.
 

 
There is a lot of new stuff that I am going to cover. Power Query has a lot of
functionality. It’s not difficult to understand, there’s just a lot of it. This is the
Power Query ribbon:
 

 
I am going to start at the first group, Get External Data.

Connecting to Data Sources

 
Before you do anything in Power Query, you need to connect to the data source.
 
Power Query can connect to many different types of data sources. I will not
cover them all, but I will show you what’s available. You can then poke around
and see what is applicable to your IT environment.
 



From Web
When you click on this button, a pop up window will appear and you can type
in the URL from which to retrieve data.
 
From File
You have many options available when connecting to file data sources. Most
are self-explanatory. You will be working with these connections in this
lesson.
 

 
From Database
In corporate environments, most of the data is stored in some type of central
database. These are the ones to which you can connect. Note that you will need
to have a database login and password to access the data.
 
Sometimes, IT people get very protective of their databases and won’t grant
you access. If you run into that, one trick that I have used is to say you need
Read Only access. This tends to calm the IT folk down quite a bit. Read Only
access means you can’t mess anything up.
 



 
From Azure
Microsoft Azure is a SaaS (Software as a Service) database technology. This
means that you can buy the software on an as-needed basis. For example,
instead of buying and installing SQL Server on a server in your company, you
could set up the database on Azure and then pay every month based on how
much you used it.
 
Microsoft also has an Azure Marketplace where you can buy access to
datasets. There are datasets related to demographics, employment statistics,
and weather patterns. It is pretty cool and much of the data you can access for



free (up to a certain record count).
 

 
From Other Sources
These are all the other data sources that Power Query can access. Look
towards the middle of the list. Did you see that? You can connect and retrieve
data from Facebook!
 
 



Hands-On Time
You will connect to a webpage from my website and see Power Query retrieve
data from the web.



 
1. Open Excel.
2. Click on the Power Query tab.
3. Click on From Web.

 

 
This window will appear:

4. Type in this URL in the URL box:
http://markmoorebooks.com/powerquery-capitals/

5. Click OK.
 
While Power Query connects, you will see this box:

Now things start to get interesting...
 
After Power Query connects, you will see the Navigator window.



 

 
The left side of the Navigator window displays all the tables that are available
on the web page. That particular web page on my site only has one table.
 

6. Click on Table 0.
 
Now you can get a preview of some of the data from the webpage on the right
side of the Navigator. The preview pane will not load all the data, just a few
records.
 

 



Bear in mind that no data has been loaded into Excel, you can peek at the data
in the Navigator. This is a neat feature that you can use for data exploration.
There’s no need to download hundreds, or thousands of records into Excel
only to find out you were in the wrong table in the first place.
 
You can also refresh the query by clicking the small page button at the top right
of the Navigator window. This is great if you connect to a table that changes
frequently, like currency exchange rate data or stock prices.

7. Click on the Load button.
 

 
Excel will connect to the web page and load the data.
 

 
 
NOTE: This is not a download of the data in the webpage; this is a live
connection to the webpage.
 
You can refresh the data in several ways:
 

Right-click on a cell in the table. Select Refresh.
 



 
Select a cell in the table. Go to the Query tab, click on Refresh.

 

 
This is the simplest method to load data into Excel with Power Query. You just
connected to a data source and pulled in the raw data. Of course, sometimes
this isn’t enough. Even in this simple example, there is a minor error. Notice
how your column headers are treated as data rows and not header rows. To fix
that, you have to shape the data.

Workbook Queries
Power Query remembers how it previously loaded data. Each load is stored in
a query package. You can see the query package on the right pane.
 
Try this.
 

8. Right-click on Table 0 in the Workbook Queries pane.
 



 
 
You can now see the columns in the query, the last time it was refreshed (Yes,
I’m working late on this for you. Don’t judge.) and the URL data source. This
is an easy way to see how recent your data is.



Query Editor
Ok, so you connected to a website, and you see that you can connect to text
files, databases, etc. You might be thinking, “Big deal, I can copy/paste or do
what I usually do to get data into Excel. So what?” Well, let’s explore the
Query Editor. The Query Editor is THE Big Deal.
 
Let’s work with a CSV (comma-separated) file to see the Editor in action.

CSV Files
 

1. Click on the Power Query ribbon.
2. Click on From File.
3. Click on From CSV.

 

 
4. Navigate to the folder where you downloaded the follow-along files

and select StatesAndCapitals.csv.



5. Click OK.
 
Whoa, this is a completely new interface. Welcome to the Query Editor! There
is a TON of functionality here. A lot of the features are self-explanatory. For
those easy ones, I will just point them out and state what they do (i.e. Sort
Ascending). The other complex features I will have hands-on time to help you
understand how to use them.
 

 
 
Queries: A workbook can have multiple queries in it. If you click on the
vertically-aligned Queries keyword along the left side, you can switch
between queries.
 
Autofilter: Autofilters (the small arrows in each column) have been
automatically applied. You can click the buttons to filter the data.
 
There’s a small button to the left of Column1 and above row 1; if you click this
button you will see many of the same options that appear in the ribbon. This is
just another way to use the same features.
 



 
Column Order: If you don’t like the column order, you can click the column
header and drag the column to where you want it.
 
Renaming Columns: You don’t have to keep the same column names as the
source data. Right-click the column and select Rename to rename the column.
 
Query Settings

 
Over on the right, you’ll see the Query Settings window. Here you can rename



the query. Right now it is called StatesAndCapitals.
 
The Applied Steps pane will record any changes you make to the data. This is
how Power Query remembers what you did and reapplies all the steps when
you click Refresh. You can also reorder your steps; step back in time to an
earlier step. You will learn how to use this feature in a later section.
 
You should be in the Home tab of the Query Editor. Let’s review the buttons in
the ribbon.
 
Close Group
This group has one button, Close & Load. Clicking this button closes the
Query Editor and returns data to the spreadsheet.
 
If you click on the small back arrow, you will get additional options letting you
load the query result to a different worksheet. By default, the data will be
loaded into the currently active worksheet.
 

 
Query Group
 

Refresh Preview - Refreshes the data.
 
Properties - Opens a new window where you can rename the query, add a
description or set the query for Fast Data Load (this might make Excel
unresponsive though).
 
Advanced Editor - This is where you can manually change the code that



Power Query generates as you use it. It’s like recording a macro except that
Power Query uses a new programming language called M. We aren’t going to
go into that in this lesson.
 
Manage Columns Group
 

 
Choose Columns: Opens a new window where you can choose which
columns to return to Excel.
 
Remove Columns: Removes the currently selected column from the query.
 
Hands-On Time: Let’s do a quick exercise before you get too bored reading
all the button functions. You should have the Query Editor open with the
StatesAndCapitals data in it.
 

1. Click on Column2 to select it. It should be highlighted to indicate it is
selected.

 

 
2. Click on Remove Columns.

 
Column2 is now gone. Ohh wait! That was a mistake. You really do need



column 2. What to do?!? Don’t freak out.
 
Everything you do in Power Query is recorded. Take a look at the Query
settings window. You can see your steps in the Applied Steps pane.
 

 
3. Undo the column deletion by clicking the small x next to Removed

Columns.
 

 
Column2 now appears in the query. You can also think of the Applied Steps as
a multiple undo feature. If you have some really dirty data and you have to add
calculations, split columns, etc., you can play around with the required steps,



see the results in Power Query and remove them if they are incorrect. At the
end of the process, you can get the cleanest-possible data set into Excel.
 
Reduce Rows Group
 

 
Keep Rows
 

 
Keep Top Rows - Keep the top x number of rows in the dataset.
Keep Bottom Rows - Keep the bottom x number of rows in the dataset.
Keep Range of Rows - Keep a specific number of rows from the data
set. You set the starting and ending rows.

 
Remove Rows
 

 
Remove Top Rows - Remove the top x number of rows from the dataset.
Remove Bottom Rows - Remove the bottom x number of rows from the



dataset.
Remove Alternate Rows - Remove a specified number of rows from
the dataset based on a pattern you specify.

 

 
Removing alternate rows is a good way to perform systematic sampling on a
dataset. In other words, when you need to use a sample of the data and you
want to keep every nth record, you can use Removing Alternate Rows.

Remove Blank Rows - Removes blank rows
Remove Duplicates - This will remove rows that are duplicates. Note
that duplicate means every field is identical. Spaces count!
Remove Errors - You can add calculated columns in Power Query. If
some of these calculations result in an error you can choose to remove
them.

 
Sort

 
Sort the data ascending or descending based on the column selected.
 
Transform
 
Here is where Power Query starts to shows its power (get it? Power Query,



shows its power? Gimme a break, Excel is hard to make funny). You can start
to shape the data in Power Query. This is the T in ETL (Extract Transform
Load). Without Power Query, you would need to add extra columns in Excel
and add the formulas there.
 

 
Let’s use a different source file that we can do some transformations on. You
are going to use an Excel file as a data source. This file is pretty messed up
and you are going to clean it up in Power Query.
 

1. Close the Power Query window (use the x at the right of the window
and discard your changes).

2. In the Power Query window, select File, From Excel.
 

 
3. Navigate to the folder where you downloaded all the follow-along

files. Select SalesData.xlsx.
 

After Power Query connects to SalesData.xlsx you will see the Navigator
window.

 



 
4. Select Table1. A preview of the table will appear in the right hand

pane.
Why select Table1 vs. Sheet1? You always want to select the smallest data set
possible. If all your data is in a table (it is in this workbook), then why load
the entire spreadsheet? Moreover, if there are additional columns with
comments, random formulas, etc., you will have to perform extra steps to clean
that data.
 

 
You don’t want to load the data into Excel yet. Don’t click Load, instead click
Edit. This will open the Query Editor.
 

5. Click Edit.
 



Now you need to start cleaning the data. Apparently, the structure of this file
doesn’t conform to accepted database standards. For example, Region is not
the only region, this column has a dash and the salesperson appended to it. You
need to split that column into two.

6. Click on the Region column to select it.
7. Click on the Split Column button.
8. Select By Delimiter.

 

 
9. Select Custom in the new window.

10. Type in a - (hyphen) in the second input box.
 

Notice those three option buttons. If you have experience with the Text to
Columns feature in Excel you’ll see that you have a few more options in Power
Query to split a column. You can choose the right-most or left-most delimiter
as the split point.
 



11. Click OK. The column has been split into two columns. Now rename
the columns.

12. Right-click on Region.1.
13. Select Rename.
14. Rename the column to Region.
15. Follow the same steps to rename Region.2 to Salesperson.
16. Select the Region column.
17. Replace the region Intl with International.
18. Click on Replace Values.

 

 
19. Fill in the box with the values to find and replace.

 

20. Click OK.
 
FYI:
 
Match Entire Cell Contents: If you put ‘art’ in the Value to Find box it will
replace the art in artist, art, part, rampart, etc. If you only want to replace cells



that only contain ‘art’ then check this box. Note that this option also exists in
Excel’s normal Find/Replace feature. You just have to click the Options button
in the Find/Replace box. It’s called Match entire cell contents.
 

 
 
Data Types
 
Let’s talk about data types. Most of the time, Excel users don’t have to worry
about data types, Excel (and Power Query) do a very good job of figuring out
numbers vs text, dates, etc. However, since you are going to be performing
analysis on imported data or including it in a chart, it is better to make sure the
data is what you expect in the beginning (on import), rather than having to
change it later.
 
Changing data types can also help you clean the data. Continue working with
the current query to see how this works.
 

1. Click on the Sales Date column header to select the column.
Based on the data you see, it is evident that this column should be of data
type Date.

2. Click on the Data Type button.
3. Select Date.

 



 
Look at your data.
 

 
The first row has an error. Something went wrong with changing the data type.
 
Take a step back in time in your data transformation process to see what the
previous value was.
 

4. In the Applied Steps, click on the Renamed Columns step.
 

 



Now you can see that the date in the first row is incorrect.
 

 
Now you have a few ways to fix this:
 

You can choose to remove the errors by clicking the Remove Errors
button.
You can add a calculated column that tests for errors and replaces errors
with a default date.
You can fix the source data.

 
The way you choose to fix the error is up to you but the goal here was to show
you that being kind of paranoid about correct data types can help you spot
errors.
 
Use First Row as Headers - This option is self-explanatory.
 
Group By - Group by is a more drastic type of data transformation. With this
feature you are actually changing your data and summarizing it as needed. You
can think of this as ‘pre-processing’ your data before it gets into Excel.
 
Let’s start with a brand new query. You can close and discard your changes or
you can insert a new worksheet and create a second query in the existing
workbook, it is up to you.
 

1. In the Power Query ribbon, click From Excel.
2. Import the GroupBy.xlsx file.

 
The GroupBy.xlsx file is very similar to the SalesData.xlsx file. I just removed
a few columns to make teaching this part a bit easier.
 

3. Click on Table1.



4. Click Edit to go to the Query Editor.
 
Now, suppose you just need to know the average Qty Sold by region. In Power
Query, you would Group the column.
 

5. Click on Group By.
 

 
6. In the new window, change the values so they match this image:

 

7. Click OK.
 
Your data set changes and now you only have the Region and the Grouped By
columns.
 



 
You can also Group by more than one column. Let’s see how that works.
 
Grouping by More than One Column
 

1. Click on the x next to Grouped Rows to delete the grouping.
 

 
C’mon, you have to admit that it’s pretty cool that Power Query remembers all
your steps and you can delete any you like. You can also click and drag steps to
change the order they are performed.
 

2. Click on the Region column.
3. Click on Group By.
4. The small + sign next to Group By is where you can add a new column

to Group By.
 



 
5. Click on the + button to add another column.
6. Change the selectors in the window to match this image:

7. Click OK.
 
 
Your dataset now has the average Qty Sold for each combination of Region and
Salesperson. For reference, this image has the raw data and the data that has
been grouped by Region and Salesperson.
 



 
Notice how there are two records for South and Barbara on the left image.
They get averaged into 602 in the right image.
 
Why would you use this? Excel already has Pivot Tables or SUMIFS. It all
depends on your needs. Excel gives you different ways to do the same thing.
Here are a few notes on why this might be better that Pivot Table/Formulas:
 

There are too many rows to insert into one spreadsheet.
Your Excel file is already slow to calculate. Adding another Pivot Table
will make it slower.
You always forget to refresh the Pivot Table.
You need to do a lot of data cleanup before you get to this point.

 
Append Queries
 
Appending queries is the act of combining two queries into one. There are a
few conditions that have to be met:



 
The two data sources must have identical data structures:
 
 

Same number of columns
Same data types in each column
Same column names
Same order of columns

 
For example, if you get the same sales data set every month and they are
identical, then you can use this method to combine the files.
 
Another example, consider the follow-along workbooks: JanSales.xlsx and
FebSales.xlsx. These files have the same structure; they just have data for
different months. You are going to append both queries.
 

1. Create a query for JanSales.xlsx.
2. Click Edit to Open the Query Editor.
3. Create a new query in the Query Editor. Click New Source, File,

Excel.
 

 
4. Select FebSales.xlsx.
5. Click OK.



6. Click on FebSales in the Navigator (FebSales is the sheet name).
 

7. Click OK.
 
Now you have two queries in the workbook.
 

8. Click on Append Queries.
 

 
9. Select the table that is not the current table.



10. Click OK.
 
Now both queries have been combined into one query. You can now return this
to Excel and build a Pivot Table or dashboard off the combined data,
 
When appending queries, the data sources do not have to be the same type.
You can append a CSV file with an Excel file, as long as they have the same
structure. Even if they don’t have the same structure, you can make them have
the same structure. Move the columns around, change the data types, rename
the columns, delete columns, do whatever you need to make them identical,
then append them. You don’t have to change the data source to fit; you shape
the data in Power Query to suit your needs.
 



 
Merging Queries
 
If you are familiar with database terms, merging queries is what Power Query
calls a SQL join. Basically what this means is that you have two tables and
they both have one field in common. You can use this common field to create a
relationship between the tables and pull records from both tables based on the
common value.
 
You can also use merge to perform aggregations on the data. For example,
suppose you have a table with customers and you have another larger table
with customer invoices. Every customer can have one or many invoices (this is
a one-to-many relationship). You can use Power Query to aggregate the
customer invoice data for you. You are going to do exactly that; join two CSV
files and use Power Query to aggregate the data for you.
 



1. Open a new Excel workbook.
2. Import Companies.csv.
3. Add a new query to CompanyInvoice.csv (click New Source, File,

CSV).
 

 
Now you should have two queries in the same workbook.
 

 
When you are performing these merges, you should spend some time
understanding your data. In this case, looking at the data shows us the
relationship between the data sets.
 



 
The ‘one’ side of the relationship is the left hand table. Each company has its
ID and the corresponding salesperson. Since there are many of the same ID’s in
the right hand table, that one is the ‘many’ side. Taking a step back, and thinking
from a business perspective, it makes sense. One company will usually have
many invoices.
 
Once again, to be clear: The goal is to build a query that will return the
company data along with the sum of all the invoices.
 

4. Click on the Companies query to select it.
5. Click on Merge Queries.

 



 
This window will appear:
 

 
6. Select Company Invoice in the middle drop down list.
7. Click on the common field in both tables. (This is important. This

creates the relationship between tables.)



 
8. Click OK.

 
Now you have linked the source files. The Power Query display shows a new
column. You need to click on the new column and tell Power Query which
records to return and that you want to perform an aggregation.
 

 



 
9. Click on the double-headed arrow in the NewColumn.

 

 
10. Select Aggregate (the options will change when you do this).
11. Select Sum of Invoice Total.

 

 
12. Click OK.

 
Now you have built a query that merges two CSV files and calculates the total
invoice amount.
 



 
Types of Joins
 
Power Query lets you define several types of joins between tables. Let’s
define them.

 
Inner: This is the most common. This will return records from both queries
where the common field is equal.
 
Left Outer: Merge will return all records from left table and only matching
records from right table.
 
Right Outer: Merge will return all records from right table and only matching
records from left table.
 



Full Outer: Merge will return all records from both tables.
 
Left Anti: Merge will return records from left table where there is no match in
right table.
 
Right Anti: Merge will return records from right table where there is no match
in left table.



 
Transform Tab
 
So far, you have reviewed all the buttons in the Power Query Home tab. Now
look at the Transform tab. You’ll see that many of these buttons are identical. I
will just review the new buttons/features in this section.
 
Table Group
 

 
The new buttons here are:
 
Transpose: Switches the column and rows in the Query Editor.
 
Reverse Rows: Reverses the sort order of the records.
 
Count Rows: This will count the number of rows and give you one record
with the row count (this is a good way to see if all the records will fit on a
worksheet).
 
Any Column Group
 

 
 
Replace Error: Replaces error values with a value you specify.
 



Fill: Fills in blank cells with data from other rows. This will not overwrite
non-blank cells.
 
Unpivot Columns: Unpivot columns is very handy. Let’s do a quick hands-on
exercise.
 

1. Close all other Power Query windows that you have open.
2. Import the file Unpivot.csv.

 
Many times you’ll receive files in this format. Having the months going across
like this is not very useful for analytical purposes. In this case, you can’t easily
sum up all the months to see a full year value. The solution is to unpivot this
data.
 

3. Shift + Click to select all the month columns. They will be highlighted
to indicate they are selected.

 

 
4. Click Unpivot Columns in the Power Query Transform tab.

 
The query will now have all the months in one column and the values in the
following column.
 



 
 

5. (Optional) - You can rename the Attribute column to Month.
 
Pivot Columns: This is the opposite of the Unpivot Columns. Using the
previous example, you highlight the Attribute column, click Pivot Columns and
Power Query will create one column for each month.
 
Text Column Group
 

 
You’ve already seen the Split Column button so I’m going to skip that.
 
Format: You can use this to format text values in a column.
 



 
 
Trim: Removes leading and trailing spaces from the column.
 
Clean: Clean is awesome! Clean removes all non-printable characters from a
column. Have you ever had a situation where you paste data into Excel and the
data skips to the next row? That is because the source data had non-printable
(and invisible) carriage returns in it. Applying clean on a column gets rid of all
the non-printable characters.
 
Extract: Extracts values from the column and replaces the column with the
values. For example, if you had a column with the full month name (January,
February, etc.) and you used Extract for the first three characters, the column
would be transformed to only have Jan, Feb, etc.
 
Parse: This command is used to connect to websites that deliver data in either
an XML or JSON format.
 
Number Column Group
 
These commands will be grayed out until you click on a column that contains
numbers. All the functions in this group will change the column contents and
apply the specified calculation.
 
For example, if you wanted to round the numbers in a column, you would click
Rounding and then Round Up, Round Down or round to a specified number of
decimal places.
 

 
 
 



 
 
Add Column Tab
 
Once again, when you click over to the Add Column tab, you’ll see many
familiar buttons.
 
Add Custom Column: This is a new feature where you can add columns with
a custom calculation.
 
Let’s work through a simple example so you can see how this works. You are
going to add a column that multiplies Price times Qty Sold to derive Extended
Price.
 

1. Import the file Salesdata.xlsx.
2. Select Table1 to import.
3. Click Edit.

 
In my case, it has been a few days since I last opened this file. I see this
prompt:
 

 
Very convenient. Power Query warns me that my preview might be stale. I’m
going to click Refresh.
 

4. Click on the Add Column tab.
5. Click on Add Custom Column.

 



 
6. Name the new column Extended Price.
7. Click after the equal sign and then enter the formula as the image

shows (You can select a column name then click Insert, or you can
double click the column name to insert it into the formula box)

8. Click OK.
 
The new Extended Price column is added to the data query.
 



 
 
 

 
 
Add Index Column: This adds a column that inserts a counter for each row.
This is useful if you need to remember, reapply, or store the original sort order
of the data.
 
 
More Power Query Tricks
 
Let me show you a few more power features in Power Query.
 
Folder Metadata
 
For this example, I am using the path C:\Common which contains all my
follow-along workbooks. When you do this exercise, use the folder that
contains your follow-along workbooks, if you want the images to match
exactly. It’s not necessary though, you’ll see. You can choose any folder you
like that has many files in it.
 
I am going to show you how to use Power Query to retrieve metadata from all
files in a folder. Metadata is data about data. This won’t retrieve the data
inside each workbook but it will give you data about each workbook. It will



make more sense when you see the results.
 

1. Open a new Excel workbook.
2. Click on the Power Query tab.
3. Click From File, From Folder.

 

 
4. Click Browse and navigate to the folder with all the follow-along

workbooks (or the folder that interests you).
 



5. Click OK.
 
Power Query returns the following data:
 

 
If you deal with many different files this is very convenient. For example, if
you are working with file submissions from other departments, salespeople or
whatever, you can run this query, load it into Excel then see who has, or has not
submitted files.
 

6. Click Close and Load.
 
The data is now in Excel in a table. OK, so what? Heh heh, just watch.
 

7. In Windows Explorer, go to the folder you selected. Create a new file
(any type) and save it to that folder. I created a new text file called
New Text Document.txt.

8. Go back to Excel.
9. Click on any cell in the table.

10. In the Query tab, click on Refresh.
 

 



The new file will be included in the query and by extension, in the table.
 

 
The query, remembers what you did. When you clicked refresh, Power Query
read the contents of the folder, parsed them and loaded them into the table. That
means as people submit files, all you have to do is refresh the existing table to
get the latest results.
 
One last thing, in the Query Editor, there is a column named attributes. The
column has an icon with two arrows in it.
 

 
If you click on that arrow, you get a pop up window where you can include
additional metadata about all the files.



 

 
Loading Multiple Files
 
Along similar lines, what if you receive several different files from other
departments that need to be combined? Yes, we did cover merging queries a
few sections ago but what if you get dozens or hundreds of files? You aren’t
really going to merge all those files by hand. There must be a better way. There
most certainly is.
 
First, a little prep work.
 
Your follow-along folder should have a sub-folder called MonthlySales. Inside
that folder there should be two files: JanSales.csv and FebSales.csv. If you
have that, you are set. If you don’t have that, create a Monthly SalesFolder and



copy those text files into it.
 
Now you are going to combine all the files in the folder with Power Query.
 

1. Open a new Excel workbook.
2. Click on the Power Query tab.
3. Click on File, From Folder.

 

 
4. Click Browse and navigate to the Monthly Sales folder.
5. Click OK.

 
Now you are back at the metadata query results you saw in the last exercise.
However, notice how the first column, the Content column has a different icon
than Attributes has?
 



 
6. Click on the Content button.

 
That’s it. The columns are combined! Now you just have to remove extra
header rows and use the headers as row names.
 

7. Click on the Transform tab.
8. Click on Use First Row as Headers.

 

 
9. Scroll down to find a header row. My data has a header row in row

20. (This is the header row from the second file.)
10. Click on Month.

 

 
11. Right-click on Month.
12. Select Text Filters, Does Not Equal.

This will remove the extra header row.
 



 
13. Click on the Home tab.
14. Click on Close and Load to return data to Excel.

 
Just like the previous exercise, Power Query remembers the steps you took.
When you get next month’s data file, just save it to the Monthly Sales folder
and refresh the table. Power Query will read the folder contents again and the
new month will be included in Excel. In other words, when clicking Refresh,
Power Query will process all the files in the folder.
 
 
 
 
Summary
 
We have gone through quite a lot of material in this lesson. And I haven’t
covered everything that Power Query can do. However, this lesson will give
you a solid foundation on Power Query that you can build upon.
 
The Power BI toolset included in Excel is very powerful, and gives regular
users the ability to manage extremely large data sets without having to call in
IT or consultants. Power Query is just the first step. Once the data is in Excel
then what? Then you need to use Power Pivot to analyze the data.
 
Power Pivot is like a super powered way to manage data sources. I will cover
using Power Pivot in the next lesson.
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Introduction
 
Welcome to another Mastering Excel lesson. If you have previous lessons,
thanks for sticking around. If you are new, I hope you enjoy the lesson. The
lessons are easy going, relaxed, no-nonsense and easy to understand. I try my
best to explain complex topics in a simple and entertaining way. My goal is
that you will finish reading each lesson and have immediately applicable skills
you can use at work or home.
 
This lesson will focus on a new Excel feature: PowerPivot. Excel is quickly
becoming a very powerful data management tool. Excel 2003 was ok in that it
could store up to 65,536 rows of data and 256 columns. Then Excel 2007 came
along and now it can store up to 1,048,576 rows and 16,000 columns. That’s a
lot of data but truthfully with technology generating so much data, that’s not big
enough. Many companies generate much more data than can be stored in Excel.
 
PowerPivot solves that issue. PowerPivot is a mini application that lives
inside Excel and can manage millions or tens of millions of records. You can
create relationships between different tables and build custom calculations
before putting anything on a worksheet.
 
You can’t see anything...
 
I want to set expectations for this lesson. If you are going to use Excel to its
maximum potential and manage large (very large) amounts of data, this is the
lesson for you. PowerPivot is how to set up the data so it can be used by other
very cool Excel features that will elegantly display the data (Power Map and
Power View). PowerPivot is the workhorse. The issue is that you really won’t
‘see’ anything in this lesson. I mean, of course you will see PowerPivot and
what it does. What I mean is that you won’t see the amazing graphs because
those are handled by Power Map or Power View. In this lesson you are
working behind the scenes getting everything ready so the other two programs
can use the data.
 
Even though the data sets you will be working with here are small, think about
managing several millions of rows.



 
 
 



What is PowerPivot?
 
Microsoft is taking Excel in a new direction. Microsoft has included in Excel
some very powerful tools to help users analyze large volumes of data. This
analysis is usually called Business Intelligence (BI). Previously, processing
and working with these large data sets was limited to experienced technical
professionals that used expensive software packages. Microsoft wants to do
away with that. They want to bring BI to the average user. They use the term
‘Self Service Business Intelligence’ to indicate that users can now perform this
analysis without calling in their IT departments or external consultants.
 
Microsoft’s toolset is called the Excel BI toolkit. It has several different tools:
 

Power Query - Used to import data
PowerPivot - Used to analyze data
Power View - Used to create presentations
Power Map - Used to create geographical presentations

 
This lesson will cover PowerPivot.
 
PowerPivot
 
There’s a new ‘thing’ in Excel you may have heard of called a Data Model.
PowerPivot is closely intertwined with this Data Model. ‘Data Model’.
Sounds intimidating right? Many IT folks like to impress non-IT people with
their terms (and Data Model is one of them) but don’t worry. It’s not that
complicated.
 
A data model is just several tables that have predefined relationships. That is,
one column of one table matches another column of another table. Those
columns can be set up as a relationship. When you do that, you are working
with a relational data model. In pure Excel terms, if you write a VLOOKUP
formula that pulls a match from a second worksheet, you just built a relational
model.
 
In my previous lessons I talk about building your Excel models in layers. The



data layer, the business logic layer and the presentation layer. The data layer is
represented as a worksheet with all your data records. That’s okay but now,
PowerPivot really is a true data layer. Not only does it have the records of
interest, but you will be able to build relationships between multiple tables
and add calculations.
 
This is a true data layer.
 
 
 



Installing PowerPivot
 
Depending on which version of Excel you have, you will need to follow
different steps.
 
Excel 2013/Excel 2016/Office 265 Office Pro Plus
 
PowerPivot is installed, just not activated. To activate PowerPivot:
 

1. Click on File.
2. Click on Options.
3. Click on Add-Ins.
4. In the drop down list at the bottom of the window, select COM Add-

Ins.
 

 
5. Click Go.
6. Select Microsoft PowerPivot for Excel.

 



 
7. Click OK.

You will now have a new PowerPivot tab in Excel.
 
Excel 2010
 
PowerPivot exists for Excel 2010. The installation is not difficult but it takes a
few steps. You need to install some programs before installing PowerPivot.
 

1. Install .NET Framework 4.0 and Visual Studio 2010 Tools for Office
Runtime.

2. If you are running Windows Vista or Windows Server 2008, install the
platform update.

3. Install Microsoft® Office 2010.
4. Download PowerPivot for Microsoft Excel. The current link on the

Microsoft website is: https://www.microsoft.com/en-
us/download/details.aspx?id=29074

 
Important: If you install the 32-bit version of Excel, you must use the 32-bit
version of PowerPivot. If you install the 64-bit version of Excel, you must use
the 64-bit version of PowerPivot.
 
Note: When you start Microsoft Office 2010 Excel for the first time, you will
be prompted for permission for Excel to load SQL Server 2012 PowerPivot
for Microsoft Excel 2010.



 
5. After you install .NET Framework 4.0 and Visual Studio 2010 Tools

for Office Runtime, click the Download button in the webpage.
6. Double-click the 32-bit or 64-bit msi file that was downloaded in step

4.
 
Note that if you are using PowerPivot for Excel 2010, the images in your
version will be different than the images in this lesson.
 
Connecting to Data Sources
 
There are several data sources PowerPivot can connect to. These include
Excel, MS Access, other corporate relational databases, text files and Power
Query.
 
Power Query
This is the simplest data source for PowerPivot. You used Power Query to
connect to the data source and prepared the data. Instead of loading the data
into an Excel spreadsheet, you loaded the data into the Excel Data model. With
the data in the Data Model, PowerPivot can connect directly to the data model
and begin working with it.
 
In general, the data flow would be something like this:
 
Data Source > Power Query > PowerPivot > Pivot Table or Power Map or
Power View
 
When in Power Query,
 
Choose ‘Load To...’ in the Import Wizard.



 
Check the box to load data into the Data Model.

 
Relational Databases
 
This is the data source you will almost always use (either directly or through
Power Query). PowerPivot is excellent at handling millions of rows. Although
you could load .CSV files with millions of rows, more often than not, you will
be connecting to a relational database.
 
I’m not going to show you how to download and install a relational database
engine; that’s out of scope for an Excel lesson. However, if doing this interests
you, search online for SQL Server Express. This is a free Microsoft database



engine that you can download and install on your PC. There are several
tutorials that explain step-by-step how to install and configure it.
 
This is how you connect to a relational database; in this case, I am connecting
to MS Access.
 

1. Click on Manage in the PowerPivot ribbon.
2. In the new PowerPivot window, click Get External Data, From

Database, From Access.
 

 
3. Fill out the requirements for the data source. I have my sample

database stored in C:\Common.
 



 
4. Click Next.

 
In this next window, you can choose to use a wizard to select a table to import
or write native SQL to retrieve data. If your IT department gave you a SQL
statement, you can select the ‘Write a query...’ option and paste in the SQL
there.
 

5. For this exercise, choose the ‘Select from a list of tables and views to
choose the data to import’.

 



 
This next step is optional but worthwhile to discuss. The sample database has
one table: Location. This table should be selected and you will be importing
the entire table. However, realistically you are not going to import entire tables
into your model. For your quarterly analysis, do you really want 20 years of
historical data? Probably not. PowerPivot gives you the ability to filter out
rows from being imported into the data model.
 

6. Click on Preview & Filter.
 



 
 
Here you get a preview of the table that is to be imported. You can uncheck a
column to skip importing it or you can click the small drop down in one
column. The small drop down displays a field icon pane (almost identical to
the Pivot Table pane) where you can choose criteria to skip rows from
importing.
 



 
 
I just said a few pages before that PowerPivot can import millions of rows and
is super powerful. Now I’m telling you that you don’t have to import all rows.
What gives?
 
PowerPivot is powerful but it is still a desktop solution. That means
PowerPivot is limited by your PC’s processing capacity and your user’s
processing capacity. PowerPivot is much more powerful than native Excel, but
it will still slow down trying to process and calculate millions upon millions
of rows. Don’t import everything, just because you can. Import what you need.
Later on, if you find out you need more data, alter the import connection to
import more rows. When dealing with huge amounts of data, you need to pay
attention to efficiency.
 

7. Click Cancel to exit this pane.
8. Click Finish to import the table into the data model.

 
The Table Import Wizard will display the records imported and if there were



any errors.
 

 
Power Query - PowerPivot doesn’t have many options to fix import errors. It
just gets the data. This is why Power Query is so useful. Power Query can
apply several sophisticated treatments to the data to clean it up and then get it
ready for PowerPivot.
 

9. Click Close.
 
Now it looks like the data is in Excel but it is not. Notice that you are still in
the PowerPivot interface. Each table will appear in its own tab (Much like



Excel. Yeah, I know it’s confusing). Remember the big picture, you will be
importing several tables into PowerPivot (the interface you are looking at
now) and then creating relationships (and calculations) between the tables.
 
Importing From Excel
 
There are two ways to import data into Excel: as a Static Table and as a
Linked Table.
 
 
Static Table
 
Sometimes, you just need to get the data into the data model. If the data doesn’t
change (suppose it is a list of sales regions), then this is the easiest way to load
data. Basically you just copy the data from Excel and paste it directly into
PowerPivot.
 
Note that when you do all the following exercises, you can leave the
PowerPivot window up, click back to Excel and do normal Excel stuff.
 

1. Open the follow-along workbook Regions.xlsx.
 

 
 

2. Highlight cells A1:A5 (Don’t highlight A6 for now).
3. Right-click and select Copy.
4. Click back to PowerPivot.
5. On the Home tab, click on ‘Paste’.

 



 
 

6. Type in the new table name. You can name it Regions.
Also notice that PowerPivot gives you the option to use the first column
copied as a column header.

 

 
7. Click OK. The Regions data has been pasted as a new table.



 

 
 
Adding New Records
 
Adding a new record to the Regions table is pretty straightforward except you
need to use a new button.
 

1. Copy cell A6 from the Regions workbook (the cell that says
International).

2. Go back to PowerPivot.
3. In the Home tab, click the Paste Append button.

 



4. The Paste Preview will appear. Click OK to paste and append the
new record.

 
This is how you add static data to PowerPivot. This means that if the source
data changes, PowerPivot will not update itself. You cannot change data
once it is in PowerPivot. Go ahead, try to type over the North region. You
can’t. PowerPivot consumes data, it does not change it. If you want to update a
static table, you need to copy the new data and select Paste Replace.
 

 
Paste Linked Table
 
This is a much more useful feature. Now you will import a table into
PowerPivot but keep the link to the table active. This means once the data in
the Excel table is updated, you can refresh the data in PowerPivot and the
newly-updated data will appear in PowerPivot. This is very similar to how
Pivot Tables work.
 



5. Right-click on the PowerPivot Regions tab.
6. Select Delete.
7. Click Yes when prompted to delete.

 

 
8. Go back to Excel in the Regions.xlsx workbook.
9. In the PowerPivot table, click ‘Add to Data Model’.

 
Excel will first create a data table.

 

 
10. Check that the data range is correct and that the ‘My table has headers’

box is checked.
11. Click OK.



 
That’s it. The new table in PowerPivot is linked to the Excel table. You can
see in PowerPivot that the linked table has a link icon in the Table tab.
 

 
Test out the link.
 

12. Change a region name. I changed South to South2 in Excel.
13. In the PowerPivot ribbon click ‘Update All’.

 

 
 
The data in PowerPivot will be updated. Note that if the source file is open,
PowerPivot will refresh automatically.
 
Data Types
 
PowerPivot is not as forgiving as Excel. When importing data, PowerPivot
will try to convert each column into one of its data types. If any cell does not
conform to that data type, PowerPivot will default to text. This is another
reason why data prep is so important when working with PowerPivot.
 
PowerPivot understands the following six data types:
 
Whole numbers: Numbers that have no decimal places between



-9,223,372,036,854,775,808 and 9,223,372,036,854,775,807.
 
Decimal Numbers: Negative values range from -1.79 e+308 through -2.23E
-308. Positive values range from 2.23 e-308 through 1.79 e+308.
 
TRUE/FALSE: Either TRUE or FALSE.
 
Text: Maximum string length is 268,435,456 Unicode characters. Unicode
means you can have characters from non-English alphabets.
 
Date: Any dates after January 1, 1900.
 
Currency: Numbers with up to 4 decimal places that range from
-922,337,203,685,477.5808 to 922,337,203,685,477.5807.
 
N/A: This is used to represent SQL NULL values.
 
You can find the exact specifications in the Microsoft website here:
https://msdn.microsoft.com/en-us/library/gg413463%28v=sql.110%29.aspx
 

https://msdn.microsoft.com/en-us/library/gg413463%28v=sql.110%29.aspx


Managing Data
 
Now that you know how to import data into PowerPivot, you are ready to
create a data model. Granted, you could just use one table, build a pivot table
and call it a day but then why bother with PowerPivot in the first place? The
big deal (well, one of the big deals, there are others I will cover later) with
PowerPivot is that you can create relationships between tables. If you have
worked with Microsoft Access, it is extremely similar.
 
Let’s start by importing a few external data sets and work with them in
PowerPivot.
 

1. Open the SalesData.xlsx workbook.
2. Click in any data cell in the Clients worksheet.
3. In the PowerPivot tab, click ‘Add to Data Model’.

 

 
You have now added a linked table to the Data Model.
 

4. Repeat steps 2 and 3 to add linked tables for the States, Products and
SalesData worksheets.

 
You should now have four separate PowerPivot tables.
 

 
Right now, you are in the PowerPivot data view. You can see the individual



data values and get a feel for the data in each table. To create relationships, it
is better to use the diagram view.
 

5. Click the diagram view button in PowerPivot.
 

 
You will see each table and the fields in each.
 

 
The data view is great to explore and get familiar with your data. Once you
know the data you can switch to this view. In this exercise, I named the key
fields explicitly and logically (I wish database people would do the same.
You’ll see when you connect to the data. Every table will have a ‘Key’ field
instead of ‘Client ID’).
 



You can see that the Clients table has a ClientID field. The SalesData table
also has a ClientID field. This is the common field and we can use this to
create a relationship between Clients and SalesData.
 
A Quick Explanation
 
If having common fields between tables is a new concept for you, look at this
image:
 

 
Using common fields means efficient data storage. It also means faster
processing. Although replacing new customer names in the gray table would
take a few seconds, imagine if you had several million tables. A Find/Replace
operation will take quite some time to finish.
 
One last point and not to get too geeky on you but you will probably hear these
terms when dealing with data; so let me explain them using the blue and green
tables in the above image.
 
Each record in a table should be identified by a unique number. That number is
a key. Since it uniquely identifies a record, it is called a primary key (PK).
ClientID is the primary key of the client table.
 
The green table also has the ClientID but you see that it is repeated. That



means it is not unique; it can’t be a primary key. The ClientID field in the green
table is called a foreign key (FK). A foreign key is always a primary key of a
different table.
 
This is waaay important for managing data. Keys enforce something called
referential integrity. It sounds freaky huh? “Hey doc, I woke up with a huge
pain in my referential integrity. Can you give me some meds so I can go to
work?” :-)
 
What it means is that every row in the green table must have a related record
in the Client table identified by a ClientID. The keys maintain the integrity of
the references between tables. Why is this important? If we did not enforce this
rule, a person could input any number of sales in the green table with no
clients! That’s fraud! You would be inflating your sales numbers by entering
false sales. No client would ever get billed.
 
All right, that’s as far as I’m going into that here. I left out A LOT of details
here, but my goal was just to give you an idea of the why and how these related
fields are so important.
 
End of Quick Explanation
 
Back to PowerPivot...
 
In the database view, creating relationships is straightforward. You click and
drag a field from one table to another table.
 

1. Click the ClientID field in the Clients table and drag it to the ClientID
field in the SalesData table.

 



 
You will see the relationship arrow between the tables.
 

 
What’s up with that weird arrow, the numbers and the asterisk?
 
More databasey stuff. The 1 means, well, 1. The * means many. That arrow is
shorthand for saying “there is a one to many relationship between Clients and
SalesData”. In other words, one client can buy many items. Yeah, that makes



sense.
 
Changing Relationships
 
If you mess up with the click and drag to create a relationship, don’t worry.
You can right-click the relationship line and select Delete to delete it.
 
Alternatively, you can double-click on the relationship line to edit the
relationship.
 

1. Double-click on the relationship line.
 
This pane appears. You can use the drop downs to change the tables and then
click the column header to change the related fields.
 

 



 
Sigh, I wish it was that easy to change relationships in real life...
 

2. Click Cancel to exit this relationship (I’m not touching that one...)
3. Click and drag StateID from the States table to the StateID in the

Clients table.
 

4. Click and drag the ProductID from the Products table to the ProductID
in the SalesData table

 
Your data model will now look like this:
 

 
Now you are going to do something pretty cool. You are going to use the data
model in a Pivot Table.
 

5. Click in Excel to start working in Excel. You can leave PowerPivot
open or close it; it’s your choice.



6. Insert a new worksheet in the SalesData workbook.
7. In the Insert tab, select Pivot Table to insert a new Pivot Table.

 

 
You will now see the standard Pivot Table window. But wait, what data source
are you going to use? Look at the pane, there’s a new button available, ‘Use
this workbook’s Data Model’
 

 
 

8. Select Existing Worksheet.
9. Select a cell for the Pivot Table location.

10. Click OK.
 
You’ll see that the Pivot Table interface looks a little different. Instead of just



columns, you see the Data Model tables and their corresponding fields.
 
Excel 2013 Users
 
You will not have the ‘Use this workbook’s Data Model’. Instead follow these
steps to source the Pivot Table from the Data Model:
 
- Click on 'Use External Data Source'
- Click on Choose Connection'
- Click on the Tables tab
- Select 'Tables in Workbook Data Model'
- Click 'Open'
- Build the Pivot Table as usual

 
 

11. Click on these fields to add them to the Pivot Table: ClientName,
Product, SalePrice, Cost.

 



The Pivot Table should look like this:
 

 
 
From now on, you can do almost anything you usually do with a Pivot Table.
Almost because Pivot Tables sourced from OLAP data behave a bit differently
than normal Pivot Tables. For example, as of this writing you cannot add
calculated fields or calculated items to this Pivot Table. Hopefully, these items
will be resolved by Microsoft soon.
 
Take a step back now and think about what PowerPivot let you do. You took
three separate worksheets, loaded them into the Excel Data Model and built a
Pivot Table using them as if they were a single table.
 
This feature alone will make your dashboards and reports exponentially more
powerful. Think about a Data Model that has data in Excel, data from your
accounting system and data from the Web. You can combine all those data
sources directly in Excel and use a Pivot Table with slicers, conditional
formatting, dynamic charts and all the other Excel features to present your
information.
 
Hierarchies
 
You can create hierarchies in PowerPivot that will make navigating fields in a



Pivot Table very easy for you and your users. Let’s see how this works.
 
You are going to add a new table to the SalesData workbook with Regions and
then map each State to a Region. Then you will set up a hierarchy where each
State is a child of its respective Region.
 

1. Insert a new worksheet in SalesData.xlsx.
2. Rename the sheet to Regions.
3. Input the Region data per the image below:

 

 
Now you have to map each State to its Region in the States worksheet. No, I’m
not going to make you do each State by hand. That’s too tedious! I have already
done the mapping for you.
 

4. Open the StatebyRegion.xlsx workbook.

The States in the States worksheet and in the StatebyRegion workbook are in
the same order, you just have to copy paste from one into the other.
 

5. Copy column B from StatebyRegion into column D in States (in the
SalesData workbook).

 



The States table should have expanded to include the new column. If it didn’t
you can manually expand the table.
 

6. Click in any cell inside the State table (you are now in the SalesData
workbook).

7. Click on the Design ribbon to design the table.
8. Click Resize Table.

 

 
9. Change the range to include column D.

 

 
10. Click OK.

 
You will see new Region column with banded row formatting applied.
 



 
All right, you added a new Region table and you added the related records in
the State table. Now you have to update the Data Model.
 

11. Go back to the PowerPivot window. If you closed it, you can click on
Manage in the PowerPivot ribbon.

 

 
Check out the States Table. The RegionID field is already there. What? How?
Remember you built this as a linked table. Any changes to the Excel table will
get reflected in the Data Model. Pretty sweet.
 

 
If the RegionID field does not show up, click on the Refresh button in the
PowerPivot ribbon.



 
Now you have to add the Region table to the Data Model.
 

12. Go to the new Region worksheet you created.
13. Click on any cell inside the table.
14. Click on Add to Data Model in the PowerPivot ribbon.

 

 
 

15. Check to make sure the range is correct. Check the ‘My table has
headers’ checkbox.

 

 
 

16. Click OK.
 
The table has now been added to the Data Model. Let’s follow best practices
and rename the table. Then create a new relationship from this table to the
States table.
 

17. Right-click on the table and select Rename.
 



 
 

18. Rename the table to Regions.
19. Click on RegionID in Regions and drag it over to RegionID in States

to create a new relationship between the tables.
 
Let’s recap. All of this has just been prep work! The ultimate goal is to create
a hierarchy of Region and State. The problem was that the Data Model did not
have the required data. You had to update the source data and then update the
Data Model. Along the way, you go some more practice with PowerPivot.
 
A hierarchy lets users drill down from a parent to a child. In this case, the user
will be able to expand the Regions to see the States under it.
 
There a few conditions that you have to follow when creating hierarchies. The
first condition (and it is a bit annoying) is that the fields of the hierarchy
cannot be in different tables.
 
 



 
See how Region Name and Name are in different tables? That’s how a good
data model is built but hierarchies don’t like that.
 

20. Click on the Grid button to see the data grid view. (It’s at the bottom
right of the PowerPivot window).

 

 
21. Click on the States table.

 
In Excel you probably have input a helper column with VLOOKUP or other
formulas to retrieve extra information from other worksheets. You can do the
same thing in PowerPivot. In this case, you are going to add a new calculated
column that will retrieve the Regions from the Region table. Conceptually, it is
exactly like writing a VLOOKUP formula. However, you are doing it in
PowerPivot and it is much simpler since you have already set up the table
relationships. Once again, we are doing this just so we can have States and
Regions in the same table.
 
Nooooo, you do not want to redesign your tables to put the Regions directly in
the States tables. If you have multi-million rows, it will slow everything down
to crawl.
 
Let’s bring in the related records from Region into States. Wait until you see
how easy this is...
 

22. Click on the first row in the Blank column, then click in the formula



bar.
 

 
 

23. Type in =Related(
 
Since there is only one relationship in this table, PowerPivot lists the potential
choices for you.
 

 
24. Choose RegionName.
25. Type in ) to close the parenthesis.
26. Press Enter.

 
The related Region names will be displayed in the States table.
 



27. Right-click on the new Calculated Column 1 and select Rename.
28. Rename the Column RegionName.

 

 
Now that you have both the parent (RegionName) and the child (Name) in the
same table, you can build a hierarchy.
 

29. Click the diagram view button (at the bottom right of the PowerPivot
window).

 

 
30. Right-click on the RegionName field in the States table.

 



 
31. PowerPivot starts by giving you the ability to rename the hierarchy.

Rename it to Geography.
 

 
32. Click and drag the Name field under RegionName (RegionName).

 



 
Now let’s see how this new hierarchy can be used.
 

33. Click back in the Excel Pivot Table.
34. Click Refresh to refresh the Pivot Table.
35. Expand the States tab in the Pivot Table fields pane. You will see the

new Geography hierarchy.
 

 
36. Drag the Geography item to the columns and remove the SalePrice

field (you are removing it so it’s easier to see the hierarchy).



 

 
Take a peek at your Pivot Table. You now see the parents Central, Northern,
Pacific, Southern and Western. However, you can click on them to drill down
to their children.
 

 
This hierarchy had just one level but you can add as many levels as you need
to. To do add more levels, drag additional fields in PowerPivot into the
hierarchy. The order of the fields under the Geography hierarchy determines
which is parent and child. You can move the fields around until you get the
right order.
 
If you drag Geography to the Filters section of the Pivot Table, Excel will filter
the entire Pivot Table by the parent or child.
 



 
Bonus Exercise
 
I think this is so cool. I had to share it with you.
 

1. Click on any cell in the Pivot Table.
2. Go to the Insert tab.
3. Click on Slicer.

 

 
4. Select Geography.

 

 
5. Click OK.

 



Two slicers are created. One for RegionName and another for Name. The great
thing is that if you select a Region, all the related States will also be selected.
Users can select a Region (and all the States in the region) or an individual
State.
 

 



Calculated Columns
 
Calculated columns are almost identical to the calculated columns you use in
Excel. In Excel, you input a formula in a cell, then you drag it down to the last
row. In PowerPivot, you just click in ‘Add Column’, input the formula in the
formula bar and press Enter. PowerPivot will apply the formula to every row.
 
PowerPivot uses a new formula language called Data Analysis Expressions
(DAX). The basic functions in DAX are similar to regular Excel formulas.
You’ll be comfortable with them soon. The more complex applications of
DAX will take some practice but they really extend the analytical capabilities
of PowerPivot.
 
Let’s create a simple calculated column that derives the Net Profit in the Sales
Data table.
 

1. In PowerPivot, go to the SalesData table.
2. Click in any cell in the ‘Add column’ column.
3. Type =[

 
You’ll see that PowerPivot displays a list of all the available fields
 

4. Finish the formula for Net Profit.
=[SalePrice]-([Cost]+[DeliveryCharge])

5. Press Enter.
6. Right-click on the new column and select ‘Rename Column’.
7. Rename the column to Net Profit.

 
Now this field will be available for you to use in the Pivot Table.
 



 
Calculated Fields
 
Calculated fields (also known as Measures) are calculations that are not
evaluated on a row by row basis; instead they are evaluated on the entire table.
For example, calculating how many units were sold in a region or by quarter
are not row-specific.
 
Calculated fields are input in the calculation area under the data table.
 

 
Once again, I know I’m sounding like a broken record but it important to keep
the big picture in mind. You could mimic calculated columns and calculated
fields directly in Excel...but not for 3 million rows. PowerPivot is for dealing



with extremely large data sets. You can certainly use it for smaller data sets
because it manages data more efficiently than pure Excel. The other reason that
these calculations are important is because the other Excel reporting tools
(Power View and Power Map) need to have the calculations in the Data Model
in order to use them.
 
Ok, enough about that. Let’s build a calculated field.
 

1. You should be on the SalesData tab, if not click on it.
2. Click in a blank cell in the calculation area.

 
Calculated Fields also use DAX formulas. As I mentioned, DAX is new but
similar to Excel formulas. An easy way to see what formulas are available is
to use the PowerPivot DAX formula wizard.
 

3. Click the Formula Wizard button.
 

 
 

4. Scroll down until you see the COUNTROWS function. Select it.
 



 
 

5. Click OK.
6. In the formula bar, finish the formula so it reads

=COUNTROWS(SalesData).
7. Change the text before the colon to read SalesRecords.

 
The final formula should look like this:
 

SalesRecords:=COUNTROWS(SalesData)
 
Note that the formula syntax is a bit different. There is a := in between
the name and the formula
 

8. Press Enter.
 
Your new calculated field will appear in the calculation area.
 



 
 
Now let’s see how this works in the Pivot Table.
 

9. Go into Excel and choose a cell inside the Pivot Table you built.
10. Expand the Sales Data table and you will see the calculated field.

 

 
11. Drag the SalesRecords field to the Values area of the Pivot Table.

 



 
The Pivot table will now calculate the number of records based on the group
and slicer settings. The SalesRecord calculation in PowerPivot, just gives
you one number, the total number of rows. However, in a Pivot Table the
SalesRecord calculation ‘listens’ to the Pivot Table and recalculates based on
your selections.
 
You can certainly test it out (and you always should test your calculations). The
Pivot Table says there are two records for Gold Game Confectioners. Double-
click on the 2 or the 43200 to drill down. Excel will pull up the individual
records. You must see two records in the new worksheet to validate the
formula is working.
 
 



 
 
Pretty cool huh?
 
You can also do aggregate calculations in calculated fields for example:
 

TotalSales:=sum(SalesData[Cost])
 
Would give you the total sales for the entire SalesData table.
 
KPI
 
KPI’s are Key Performance Indicators. They are metrics that you design and
they create visual alerts in PowerPivot to call attention to values that are out of
line. In other words, KPI’s work like the Icon Sets in the Excel Data Validation
ribbon.
 
Let’s create a KPI so you can see how it works.
 
A KPI needs a calculated field as a base. Let’s create a new one.
 

1. Click the calculation area in the SalesData tab.



 
2. Type in this new calculated field:

 
AvgNetProfit:=AVERAGE([Net Profit])

 
3. Right-click on AvgNetProfit and select ‘Create KPI’.

 

 
Note that KPI’s are only available for measures created in PowerPivot. If you
create a calculation in Excel and then include it in PowerPivot, the calculation
will not be available for a KPI to use.
 

4. Change the KPI window so it matches these values (Absolute value
15000, select the first icon style and move the slider to around where I
have them, it doesn’t have to be exact).

 



 
5. Click OK.

 
The KPI in the calculation area now has a small icon added to it as an
indicator that there is a KPI associated with it.
 

 
The KPI is also added to the Pivot Table.
 



6. Expand the SalesData fields to see the new KPI.
 

 
 
Go ahead and change the Pivot Table to see how it can now include the
calculated field and the Status. I changed my Pivot Table around and this is
how it looks:
 

 
There’s a lot going on in this small Pivot Table.
 

It has limited the data to only the customers that are in the Northern
Region. Recall that we set up Region as a hierarchy.
It is displaying the Net Profit which was never calculated in Excel; it is a
Calculated Column in PowerPivot.
It has a Calculated Field (AvgNetProfit). AvgNetProfit is calculated for
each customer. (This is very nice. I only created one formula in the
calculation area but I can use it for every customer).



The Avg Net Profit Status KPI appears in the Pivot Table.
 
Optional Mini Exercise
 
Here’s a small test to make sure that the data is flowing through from Excel to
PowerPivot, through the calculated Fields/Calculated Columns/KPI and into
the Pivot table.
 

1. In Excel, go to the SalesData worksheet.
2. Find a data point that is in the Pivot Table.

 
For example, I want to change Gold Game Confectioners. The Clients
worksheet tells me that it is ClientID 7. I use Autofilter to find the rows that
have ClientID =7 in Sales Data.
 

 
3. I’m changing D81 to another number. I’m adding a few zeros to make

it 4125000.
4. Click back on the Pivot Table.
5. Right-click on a Pivot Table cell and Select Refresh.

 
The Pivot Table values and the KPI should update. If they do, all your data
linkages are working.
 

 
Calendar Table



 

 
Take a look at the raw data in the SalesData table you’ve been working with.
So far, it has served you well for learning PowerPivot but truthfully, it’s not
enough for meaningful analysis. For example, what if you want to analyze
TotalDiscount by month, or Net Profit by quarter? There is no way to do that in
PowerPivot. PowerPivot doesn’t know what a month is, or what a quarter is.
Remember, you can’t change data in PowerPivot, if it isn’t loaded or
calculated in PowerPivot you are out of luck.
 
The solution is to create a Calendar Table that stores all the dates in the raw
data and assigns date measures to each record. For example, a Calendar Table
would have every single day (No gaps allowed! Gaps will mess things up!)
in one column and the quarters, months, etc. that the day corresponds to. You
then load the Calendar Table into PowerPivot, set it as a date table and create
a relationship to the SalesData table.
 
 
Basically the Calendar Table will have every possible date representation you
will need in your visualizations, year, month, quarter, etc.
 
By the way, when building a Pivot Table, PowerPivot tries to help you in this
respect. I’m not sure if you noticed but PowerPivot already parsed out the
Invoice Date into Date measures.
 



 
If all you are doing is building Pivot Tables and you just need Month, Quarter
and Year, you are all set. However, if you want to use Power Map, Power
View or more date measures, you will need to build a Calendar Table.
 
The easiest way to build a Calendar Table is to use Excel. List the days in one
column and use the built-in Excel date functions for the rest of the columns. I’m
not going to make you do all that work! I have a basic Calendar Table that you
can use to get you started. Once you have it set up to have what you need, you
just have to import it into each PowerPivot data model you build.
 
Let’s do that now.
 

1. Go to PowerPivot (if you were in Excel).
2. In the Home tab, click ‘From Other Sources’.

 

 
3. Towards the bottom of the list, click ‘Excel File’.



 

 
 

4. Click Next.
5. Browse to the location of the follow-along workbook

CalendarTable.xlsx.
6. Check ‘Use first row as column headers’.
7. Click Next.
8. Click on Sheet1 in Friendly Name and rename the tab to

CalendarTable.
 



 
9. Click Finish.

10. Click Close.
 
Now you have to tell PowerPivot to treat this table as a Date Table.
 

11. In the Design tab, click ‘Mark as Date Table’.
 

 
 

12. Select Day as the Date field. (Note that the field must have unique
values).

13. Click OK.
 
Now you just have to create a relationship between the Calendar Table and the
table that has the data you want to analyze over time (SalesData).



 
14. In the Design tab, click ‘Create Relationship’.

 

 
 

15. In the Create Relationship window, select SalesData as Table2.
16. Click on the Day field then on the InvoiceDate field to set up a

relationship between the two.
 

 
17. Click OK.

 
Note: In my case, every once in a while, I get a ‘Create Relationship Failed’



error (No jokes about this! :-) )
When I click OK, again the relationship is created successfully. If this happens
to you, try recreating the relationship until it works.
 
Pivot Table Tip
 
Let me throw this in here.
 
When you have Date fields you can use a new type of Filter, the Timeline to
control Pivot Tables.
 

1. Go back to your Pivot Table.
2. Click on the Insert tab.
3. Click on Timeline.

 

 
4. Click on InvoiceDate.

 



 
5. Click on OK.

 
Now your users have a much more intuitive way to select a range of dates and
see the related data in a Pivot Table.
 

 
 
Dashboards
 
Now you can use PowerPivot to manage million and millions of data points.
You create a few calculated columns and a few calculated fields. Then you
have to use a Pivot Table to present your data. Really? Granted, Pivot Tables
are very powerful, they can be augmented with slicers and timelines but you
can’t really make a dashboard with them. You can’t insert rows in the middle
of a pivot table. Formatting is pretty tedious. There must be a better way.
 
There is a better way. Go get some coffee, take a breather or something
because what I am going to show you is way cool and almost no one knows
about it.
 
I’m going to show you how to create a dashboard with formulas that can read
data directly from the Data Model...no Pivot Table needed. Think of it as a
VLOOKUP that retrieves data from the Data Model.
 
Let’s start by creating a simple formula that pulls in SalePrice then you can get
creative and make it more flexible.
 
New Formula: CUBEVALUE
 



You are going to use the CUBEVALUE formula to retrieve data from the Data
Model. This formula lets Excel connect to a data cube.
 
You are familiar with tables and table relationships. Those systems are very
good for data storage. For analysis, those systems slow down considerably.
There’s a technology where you can store the data in a multidimensional cube.
Users can pivot the data in the cube to drill down/up to perform analysis. This
is called OLAP (Online Analytical Processing) and the cubes are called OLAP
cubes. A PowerPivot data model is one of these types of cubes; that’s why you
can use the new cube formula to retrieve data from the Data Model.
 
The syntax for CUEBVALUE is:
 

=CUBEVALUE(connection,member_expression1,...)
 
CUBEVALUE retrieves data from the calculation area of PowerPivot. You
only created two calculations so far, SalesRecords and AvgNetProfit.
However, PowerPivot created some Implicit Measures for you. In other
words, PowerPivot did some calculations but didn’t tell you about them.
 

1. Insert a new worksheet in the SalesData follow-along workbook.
Name it Dashboard.

2. In PowerPivot, click on the Advanced tab.
3. Click on ‘Show Implicit Calculated Fields.

 
Now you can see all the measures in the SalesData tab.
 

 
You are going to start by retrieving the NetProfit from the Data Model. This
formula will be the basis of the dashboard.
 



4. Choose a cell around F12 or so. Type in this formula:
 
=CUBEVALUE("ThisWorkbookDataModel","[Measures].[Sum of SalePrice]")
 
This formula connects to ThisWorkbookDataModel and retrieves Sum of Sale
Price from Measures (remember that Calculated Fields are also called
Measures).
 
This is ok, but you need some more granularity of the data. Let’s change it so
we can see Sum of SalePrice for the Northern Region (remember that the
Northern region is part of the hierarchy you created. Yes, those are still
available to this formula.)
 
You just need to start specifying additional criteria in the CUBEVALUE
formula. The criteria follows the form of [Table].[Field].[Value].
 
To get sales for the Northern Region, change the formula so it read like this
(You’ll also notice that Excel helps you by displaying the available
fields....very handy):
 
=CUBEVALUE("ThisWorkbookDataModel","[Measures].[Sum of
SalePrice]","[States].[RegionName].[Northern]")
 
You should see a cell with $527,690.
 
The rest of this exercise is going to be basically splitting up the above formula
to point to cells with the values instead of hardcoding them inside the formula.
 

5. Set up your dashboard like this:
 



 
Instead of having “Northern” hardcoded in the formula, you are going to build
the string using the & operator.
 

6. Change the formula to this:
 
=CUBEVALUE("ThisWorkbookDataModel","[Measures].[Sum of
SalePrice]","[States].[RegionName].["&$C12&"]")
 
C12 has the region name. Now you have made the formula more flexible.
 

7. Add a new member expression to retrieve data by year. The updated
formula is:

 
=CUBEVALUE("ThisWorkbookDataModel","[Measures].[Sum of
SalePrice]","[States].[RegionName].["&$C12&"]","[CalendarTable].[Year].
["&D$11&"]")
 

8. Drag the formula down and across to fill out the dashboard.
 
I added some formatting to make my dashboard look pretty for you.



 

 
Since these are formulas, you can insert rows and apply whatever formatting
you like, this is much more flexible than a Pivot Table. Of course, the
drawback is that this is not suited for any type of ad-hoc analysis, you can’t
pivot anything.
 
Do you realize how cool this is? Theoretically, you can have multi-million
data rows in PowerPivot and build a dashboard off all that data without ever
using a Pivot Table.
 
But wait, there’s more. It gets even better...
 

9. Click on the Insert tab.
10. Click on the Slicer button.

 

 
11. Click on the Data Model tab.

 



 
12. Click Open to open the data model.
13. Scroll down the pane and select Product.

 

 
 

14. Click OK.
 
This slicer is now directly connected to the Data Model and will retrieve all
the Products.
 



 
Now you are going to connect the Slicer to a cell.
 

15. Right-click on the slicer and select Slicer Settings.
16. Don’t change anything here but make a note of the name of the slicer. It

is Slicer_Product. You will need that shortly.
 

 
17. Click on the cell right under the label “Sum of Sale Price”. In my

dashboard it is cell C9.
 



 
18. Type in this formula:

 
=CUBERANKEDMEMBER("ThisWorkbookDataModel",Slicer_Product,1)

 
CUBERANKEDMEMBER is the cube formula that retrieves a specific
member from a data set. In this case, the data set is the Slicer_Product data set
and it is retrieving the first value.
 

19. Change the selected product slicer to see the new value reflected in
cell C9.

 
Note: This trick will not work with multiple slicer selections.
 
Guess what you are going to do next? Yup, add another member expression to
include Product in the CUBEVALUE function.
 

20. Update the formula to include a reference to cell C9 (or your
particular cell that is linked to the slicer).

 



=CUBEVALUE("ThisWorkbookDataModel","[Measures].[Sum of SalePrice]","[States].
[RegionName].["&$C12&"]","[CalendarTable].[Year].["&D$11&"]","[Products].["&$C$9&"]")
 

21. Drag the formula down and across to fill in the dashboard.
 

 
Now as you select a product using the slicer, the CUBEVALUE formula will
read the linked cell and return data from the Data Model.
 
DAX Formulas
 
In this lesson, I only briefly touched on DAX formulas. This was by design.
DAX is an enormous topic that really deserves its own lesson.
 
This was quite the lesson wasn’t it? You are further into the world of Business
Intelligence. This is where Excel is going. Get up to speed with this and you
will be way ahead of everyone else.
 
I hope I have given you enough of a PowerPivot foundation so that you can
continue learning and developing your skills.
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Introduction
 
Welcome to another Mastering Excel lesson. If you have previous lessons,
thanks for sticking around. If you are new, I hope you enjoy the lesson. The
lessons are easy going, relaxed, no-nonsense easy to understand. I try my best
to explain complex topics in a simple and entertaining way. My goal is that you
will finish reading each lesson and have immediately applicable skills you can
use at work or home.
 
What is PowerView?
 
Microsoft is taking Excel in a new direction. Microsoft has included in Excel
some very powerful tools to help users analyze large volumes of data. This
analysis is usually called Business Intelligence (BI). Previously, processing
and working with these large data sets was limited to experienced technical
professionals that used expensive software packages. Microsoft wants to do
away with that. They want to bring BI to the average user. They use the term
‘Self Service Business Intelligence’ to indicate that users can now perform this
analysis without calling in their IT departments or external consultants.
 
Microsoft’s toolset is called the Excel BI toolkit. It has several different tools:
 

Power Query - Used to import data
PowerPivot - Used to analyze data
Power View - Used to create presentations
Power Map - Used to create geographical presentations

 
This lesson will cover Power View.
 
Power View
 
Power View is a new feature of Excel that lets you create graphical analysis
and interactive presentations. Power View is great for data exploration and for
creating presentation where users can interactively drill down into the data.
Power View does not replace PowerPoint. PowerPoint is great for creating a



slideshow with animations, callouts, videos, sounds etc. Data is the main
driver of Power View. You don’t make slides but instead you make interactive
data elements that help you and your users understand the underlying data.
 
Power Pivot and Power View
 
The Data Model you are using is the same one that was built in the Power
Pivot lesson. Power Query and Power Pivot are closely intertwined and later
on in the lesson, you will be going back to Power Pivot for a few exercises
then back to Power View. This is by design. There were a few Power Pivot
topics that I thought were very interesting and cool but I left them out of the
Power Pivot lesson. My reasoning was that in the Power Pivot lesson, I would
have shown you how to do a task in Power Pivot but not show you how to use
it (since it was used in Power View).
 
I didn’t think that was too useful, showing how to do something without the
why. Since the why is in this Power View lesson I’ll get to show you both, the
how (in Power Pivot) and the why (in Power View).
 
 
Installing Power View
 
Power View is available for Office Professional Plus, Office 365 Professional
Plus and the Standalone Version of Excel 2013.
 
Silverlight
 
Power View uses Silverlight, a Microsoft product. If you have the right version
of Excel, you need to also make sure that you have Silverlight installed. Rather
than give you a Microsoft URL that might be invalid in the future, just search
for ‘Install Silverlight’ and go the Microsoft website that appears in the search
results.
 
Power View should be in the Insert ribbon. The icon looks like this:
 



 
If the button is not there (or if it is greyed out), follow these steps to activate it.
In Excel,
 

1. Go to File.
2. Click on Options.
3. Click on Add-Ins.
4. In the Manage box, select COM Add-ins.

 

 
5. Click on Go.
6. Click on the box next to Microsoft Power View from Excel.

 



 
7. Click OK.

 
Excel 2016
 
For some reason, Microsoft removed the Power View button from the Excel
2016 ribbon. This is how to add it:
 

1. Click on File.
2. Click on Options.
3. Click on Customize Ribbon.

 

 
 
You are going to add the Power View button. However, buttons need to be
added to Custom Groups. You need to create a Custom Group first. This
example will add a Custom Group to the Insert tab although you can add it to
whichever group you like.
 

4. Click On the Insert tab.



 
 

5. Click on New Group.

 
6. In the left pane, select Commands Not in the Ribbon.
7. Scroll down and select Insert a Power View Report.

 

 
8. You should have both the new group and ‘Insert a Power View Report’

selected. Click on Add.
 



 
9. Click on New Group (Custom).

10. Click on Rename.
11. Rename the Group to something more appropriate (MyReports, Power

View, etc.).
 
The Power View button has been added to the Ribbon in a Custom Group
 

 
Tables
 
Tables are the simplest type of graphic to display in Power View. We will start
with this and then move onto more complex data visualizations.
 

1. Open the follow along workbook SalesData.xlsx.
 



This workbook has a Data Model in that that you will use to as the data source
for the Power View reports. Each Power View report lives in its own special
Power View sheet. On this sheet you will add all the various graphical
elements to build your data exploration/data visualizations. Unfortunately, you
cannot embed a Power View report in a normal worksheet.
 

2. Click on the Sales data worksheet to activate it.
3. Click on the Power View button.
4. Select Create a Power View sheet.

 
You will see that Power View built a table based on the SalesData worksheet.
This simple table is a good starting point to explore the various options that
are available in Power View.
 



When clicking on the table, you will see borders that can be clicked and
dragged to resize the table. When you click inside the table, you will see that a
new Design tab appears. Here you can change the look of the data table.
 

 
Change Number Formatting

5. Click on any number in the Cost column.
6. In the Design tab, select Number from the drop down list.

 

 
You will probably need to resize the Cost column, and it’s not obvious how to
do that.
 

7. Hover the mouse over the column title. When it is highlighted and the
cursor changes to a double arrow, drag the right edge of the title to
resize the column.

 
Use the scrollbar to move to the bottom of the table. You will see that a nicely
formatted total row has been added for you.
 



 
Adding New Fields
Look over to the right of Power View and you’ll see the Power View Fields
pane. (If it is not visible, select Field List from the Power View tab). You can
use this pane to add new fields to the table. There are a few ways to do this.
You can either:

Drag a field from the field list directly to the table
Drag a field down to the field list
Click on the checkbox next to the field which becomes bolded

 
8. Add the Net Profit field to the table.
9. Format the Net Profit field to anything you like.

10. Resize the columns and table so you can see the data.
 
Reordering Columns
You don’t reorder columns directly in the table; you click and drag the columns
to change the order in the fields list.
 



 
Changing the Default Calculation
By default, Power View will apply a sum to all numeric fields. However, this
can be changed to suit your needs. You can click on the small black arrow next
to the field in the Field List to change the aggregation calculation.
 

 
Sorting
To sort a column you just need to click on the column header. A small arrow
will appear to indicate that the column has been sorted. One caveat: Once a
table has been sorted you cannot unsort it. You can still sort it based on another
column but you can’t get the table back to the original sort order.
 
Power View Sheets
 
Notice that each Power View report lives in its own worksheet.
 

 
You can rename the Power View sheets just like a normal worksheet. For the



rest of the lesson, you can delete the Power View object (select a cell in the
table and press the Delete key to delete an object) and start anew, or you can
insert a new Power View sheet and keep your previous work. It’s up to you.
 
Yes, you can even continue to add new objects to the Power View sheet (that’s
what you would do in a real situation) but for this lesson’s purposes, where
possible, I am going to be using a new (blank) Power View sheet.
 
Matrix Tables
 
Let me show you about Matrix Tables. (I’m starting in a new Power View
Sheet.)
 

1. In the field list, click on RegionName, then State Name, then Net
Profit.

 
This will create a table that looks like this:
 



 
Yeah, that’s ok. Nice, but you can do the same thing in Excel. So what? Well,
let’s see what capabilities Power View has for this basic table.
 
You are going to convert this table into a matrix table. (Are you going to take
the Blue pill or the Red pill? Do you want to see how deep this rabbit hole
goes?)
 
(Ohh come on! You KNEW I was going to talk about that movie at some point!)
 

2. In the Design ribbon, click on the Table button (If the Design tab is not
visible, click inside the table).

3. Click on Matrix.
 



 
The resulting matrix table looks more polished than a plain data table.
 

 



Drill Down
 
If you worked through the Power Pivot lesson, then you should be familiar with
the Excel Data Model. If not, basically, a Data Model is a series of tables that
is imported into Excel. You then build relationships and calculations between
these tables. Pivot Tables and Power View reports can be sourced from the
Data Model.
 
The States table in this Data Model contains a hierarchy. State Name is a child
of Region Name. You can see this in the matrix table, where Utah and
Washington are children of Pacific.
 
Optional
If you want to see the Data Model, follow these steps:
 

1. Click on the Power Pivot tab.
2. Click on Manage.

 

 
3. In the Power View Home tab, click on Diagram View.

 

 
 



You will see a graphical representation of all tables and their relationships.
Additionally, you can see all the hierarchies that have been defined. Here is a
screenshot of the Geography hierarchy in the States table.
 

 
 
Ok, back to Drill Down.
 
Since there is an explicitly-defined relationship between RegionName and
StateName, you can set up a Matrix Table to drill down from Region to State.
 

1. Go back to Power View (click on the Power View worksheet) if you
left to go check out the Power Pivot Data Model.

2. In the Design tab, click on the Show Levels button.
3. Click on ‘Rows - Enable Drill Down One Level at a Time’.

 



 
 
The table has been collapsed and the States have been removed (or have they)?
 

 
4. Click on Central.

 
You will see a downward pointing arrow:
 

 
5. Click on the arrow to drill down to see the States in the Central

Region.
6. You can click the upwards pointing arrow to go back to the Region

level.
 



This particular hierarchy only has two levels, Regions and States. If you build
your Data Model with a deeper hierarchy, you can continue to drill down to as
many levels as you include in the Power View Report.
 
Removing Drill Down
 
To remove the drill down feature, you can click on the Show Levels button,
and then select ‘Show All Grouping Levels at Once’.
 

 
 
Column Drill Down
 
Everything you just did for row drill down is applicable to column drill
downs. All you need to do is click and drag the fields to the column area of the
field list.
 



 
Row and Column drill downs are not exclusive. What I mean is that you can
have a Region drill down on the rows and a separate column drill down on the
columns (e.g. maybe you have a time drill down on the columns years to
quarters to months).
 
Cards
 
Cards are a new way to visualize data. Let’s see what they look like.
 

1. Start with the Matrix Table you’ve been working with (or you can
create a new one that looks like the image below).

 



 
2. Click on any cell in the Matrix Table to make the Design tab appear.
3. In the Design tab, click on Table, then Card.

 

 
The Matrix Table now displays the data with each record in its
own card.

 



 
Your card table might look different than mine. That’s because the card change
based on the width of the report. Click on the border handles to change the
card width (cursor changes to a double arrow), to see how the items in it are
rearranged.
 

 
Card Styles



 
You can change the look of the cards by going to Design, Card Style, Callout.
 

 
This will make each card much larger. If you resize the larger callout items,
they can be placed as titles or used as pop-outs.
 
Key Performance Indicators (KPI)
 
KPI’s can also be shown in Power View. You can display them in Cards,
Matrix Tables, Tables, etc. Since the last exercise dealt with Cards, let’s add a
KPI to the cards.
 
KPI’s have to be set up in Power Pivot; you cannot set them up directly in
Power View. This is one of those items where the data layer (the Data Model)
does the hard work and the Presentation Layer (Power View) displays the
results elegantly.
 
The Power View fields pane tends to revert to only show you the fields that
have been used in a report. To add new fields from different tables, you will
need to click the 'All' button.
 

 
1. Click on All in the Power View Fields list.
2. Find the AvgNetProfit KPI in the data model. It is in the SalesData

table. KPIs have a small “traffic light” icon on them.
 



 
 
 

3. Click on Status to display the KPI in the card.
 

 
You can use the Table button in the Design tab to see how the KPI’s are
displayed in Tables and Matrix Tables.
 

 
Basic Power View Charts



 
Let’s start building charts in Power View. This is what you really wanted to
learn right? How to make amazing charts? We will begin with a few simple
charts. I’ll show you how to build them, how to make adjustments to them, and
then in the next section, I’ll go into advanced charting tricks.
 
All the standard chart types are supported in Power View: Line, Column, Bar,
Pie, etc. I will show you how to build one or two of these basic charts and then
go on into how to adjust them. I am sure that once you see how to build one
basic chart, you will be able to figure out how to build the others easily.
 

1. Create a new Power View report.
2. Click on Client Name to add that field to the report.
3. Click on Net Profit to add that numeric field to the table.

 

 
4. Click on any cell to make the table the active object.
5. In the Design ribbon, click on Bar Chart, Clustered Bar.

 



 
 
Guess what? You have built your first chart in Power View. That’s all there is
to it!
 

 
Let’s review some basic chart adjustments.
 
Resizing Text



 
With the chart selected, you can increase or decrease the chart font size with
these buttons (in the Design tab). Unfortunately, you cannot specify a font size
in Power View.
 

 
Sorting Chart Data
 
By default, the data in a chart is sorted alphabetically. You can change this in
Power View. Hover your mouse over the chart and look at the top left of the
chart. Small notifications appear in that corner.
 
 

 
1. Click on the small grey arrow to sort by the other fields in the chart.

 

 
2. Click on ‘asc’ (ascending) to change the sort or to ‘desc’ (descending).
3. Click again to change back to ‘asc’.

 



Power View Fields (for Charts)
 
Let’s see what else we can do with charts. Take a look at the bottom of the
Power View Fields pane. There’s a bunch of stuff there.
 

 
 
 
Legend
 

1. Click and drag the RegionName field over to the Legend box.
 
You’ll see that each RegionName has been set as the legends and each column
has a different color.
 



 
 
Tile By
 

2. Click and drag RegionName from Legend to Tile By.
 

 
Now the chart shows each Region in its own page.
 



 
(Admit it. That’s cool...)
 
Vertical Multiples
 
Since you have RegionName in the Tile By box, you should see this in the
Vertical Multiples box.
 

 
This just means that you can’t drag any new fields from the Data Model into the
Vertical Multiples box.
 

1. Drag RegionName back to the Legend box.
2. Drag RegionName to the Vertical Multiples box.
3. Resize the chart to show the data a bit better.

 
The Vertical Multiples feature takes each value from RegionName and creates
a chart for each Region.



 

 
Horizontal Multiples
 

4. Drag Region Name to the Horizontal Multiples box.
 
Now each chart is stacked side by side in a row.
 
Resizing Multiples
 
For both Vertical and Horizontal Multiple charts, Power View uses a grid
system to place each chart. You can change the default grid to fit more charts
on a page.
 

1. With the Horizontal Multiples chart selected, click on the Layout tab.
 
In this tab, you can add chart legends, data labels, etc.



 
2. Click on Grid Width.

 

 
3. Change the Grid Width a few times to see how the charts react.

 
Note: Grid Width affects Horizontal Multiples only while Grid Height affects
Vertical Multiples.
 
Now, you can build basic charts and I know you want to move onto more
advanced charting but we can’t. Not just yet. You might not have noticed this
but these charts really aren’t that useful. They don’t really show meaningful
segments of the data. What do I mean? This horizontal multiple chart shows
data for all years. For meaningful analysis, you probably want to narrow down
the data to just one particular year of interest.
 
This brings us into Data Filters…
 
Data Filters
 
Data filters are very important. They let you and your users narrow down the
data set to focus in on smaller segments. For example, looking at one year in a
chart is more useful than only looking at all years lumped together.
 
Filtering data in Power View works very similar to the regular Excel
Autofilter. You can search for one specific value, select several values, etc.



Even if you haven’t been exposed to Autofilter before, once you see the
interface, you will find it pretty intuitive.
 
The Data Filter pane is in between the Report pane and the Fields pane. It is
helpfully titled, ‘Filters’. If you don’t see the Filters pane, click on the ‘Filters
Area’ button in the Power View ribbon.
 

 
 

 
 
Creating Filters is pretty simple. Let’s build a new report and add a filter to it.
 

1. Create a new Power View report.
2. Click on City to add it to the report.
3. Click on SalePrice, Cost, DeliveryCharge and Net Profit.

 
You should have a chart that looks like this:
 



 
If you didn’t click the fields in order, you can rearrange the order by dragging
them in the Fields List pane.
 

 
4. Format the numbers so they look more appealing. I applied the number

format with no decimals.
 

 
 
Add a second Power View object to the report.
 

5. Click on an empty area in the report to deselect the table you just
created.



6. Click on ClientName.
7. Click on Status.

 
You should have two reports that look like this:
 

 
 

8. Resize the objects so you can see the client name (hover over the
column title and drag the edge of the blue box).

 
There are two types of filters you can apply in Power View: view filters and
object filters.
 
This is the only confusing part about filters.
 
View filters filter the data for every object in the report. Object filters
filter the data for the object they are applied to.
 
That’s it. View filters are for everything in the report, object filters are just for
a specific object. Both filters can interact. What I mean is that you can have a
View Filter that excludes France (for example) and then an object that excludes
USA. The object will not show any data for France or USA. As a matter of
fact, the object will never be able to show data from France since the View
filters excludes France. Note: View filters take precedence over object filters.
 



View Filter
 

1. Click on an empty part of the report and make sure that the Filters area
only says ‘View’. This is important. If you don’t do this it will mess
up your View filter.

 

 
 
 

2. Click and drag RegionName to the Filters area.
 

 
Now you can select one or more regions and both report objects will update to
show only the data segments you chose.
 
Note: Those numbers you see in the filter box represent the number of those
particular items that are in the underlying data table. This is for informational



purposes only; it does not affect your report.
 
Collapse Filter - Click on the small triangle to the left of RegionName to
collapse the filter. I selected Central and Pacific for this example. I think it’s
pretty convenient that my choices are displayed under the field name. Now I
can still see the items selected with the filter collapsed.
 

 
Advanced Filter Mode - Click on the arrow to open this new pane. Here you
can apply more complex selection criteria.
 

 
 
Erase Filter - The little square (it’s supposed to be an eraser) lets you clear
the filter.
 
Delete Filter - Clicking the X removes the filter.
 
Filters change based on the volume of data and the data type. It does make



dealing with large amounts of data easier.
 
Search - If the list of items is very large, the filter will include a Search box.
 

3. Drag over the City field to see the Search box.
 

 
The search box supports the use of wildcards, just like Excel. (‘*’ is used to
represent any number of characters and ‘?’ is used to represent one character)
 
Numeric Filters
 
You can also filter by numbers. For example, suppose you only want to look at
customers that have a certain range of profitability. You can drag the field to
the Filter area and set a range.
 

4. Drag the Net Profit field to the Filters area.
 

 
 
If you don’t like this range filter, you can click the right pointing arrow and go
into List Filter mode for the filter.
 



 
Click the arrow button again and you will get to the Advanced Filter mode.
Yes, three clicks on the same button for three different features.
 
Dates - The advanced filter for Date fields looks a bit different. You get a nifty
calendar tool to choose the start and end dates.
 

5. Drag the Invoice Date field to the Filters area.
6. Click on the Advanced Filter button (the right pointing arrow).

 

 
 



The neat thing about the Filters area is that you can see every filter that has
been applied. I collapsed all my filters and I can still see what segments of
data the report is focusing on.
 

 
 
Object Level Filters
 
Object filters (also called Visualization filters) are filters that are only applied
to one specific object. The good news is that the skills you used for view
filters are identical when used for object filters.
 
The only difference is this: when you click on a Power View object, the Filters
pane will have two tabs: View and Table. Any field put into the View tab will
affect all objects in the view. Any filters put in the Table tab will only
affect the currently selected object.
 

 
It might happen that as you use Power View you find that you simply cannot
find one data element (i.e. “I KNOW we had sales in the UK, why isn’t this
stupid Power View letting me see them?!?!?”). Before you drive yourself
crazy, go take a look at the View filters. It might be that you filtered out UK at



the view level and then the individual objects can’t show it.
 
Adding Text Boxes
 
Filters can get pretty intricate. For your users (and maybe for yourself) you
might want to make several notes directly on the report that explicitly state
what is being excluded from the report. Not everyone is going to take the time
to look over in the Filter pane to see what is going on. They are mostly just
going to look at the graphs and start clicking.
 
You can add notes and comments to Power View by inserting a text box.
 
In the Power View ribbon, click on Text Box to insert a text box. You can start
typing your comment. When you are done, the Text ribbon will be available for
you to adjust the appearance of the text.
 

 
 

 
 
Slicers
 
A drawback that filters have is that they are easy to overlook. A user can hide
the Filters pane and not realize that values are being excluded from the
analysis. Slicers are a more obvious way to allow users to narrow down the
data they see in Power View.
 



1. Create a new Power View report (if you choose to use the existing
report and just delete the objects, make sure you also delete any filters
that were previously set).

2. Click on ClientName and Net Profit.
 
You will have this table:
 

 
 
Now let’s set up a slicer that will let users (and you) limit data by Region
Name.
 

3. Click and drag RegionName into the report.
You can’t just click it because that will add it to the table. You do not want to
add it but make it a separate report object.
 

4. With the new RegionName object selected, click on Slicer in the
Design ribbon.

 



 
Now when you click a region the Net Profit table will be limited to the
Regions selected in the slicer. You can use CTRL + Click to select multiple
regions.
 
Filter and Slicer Interaction
 
View filters supersede slicer options. In the image below I added a view
filter that set the view to show only Central, Northern and Pacific regions. The
slicer now only shows those regions as potential choices.
 
 

 
 
Table filters supersede view filters. I changed my report so that there are no
view filters. There is a table filter that limits table data to Central, Northern
and Pacific. Notice how the slicer still has the other two regions (Southern &
Western) displayed. You can click on Southern but the table will not show any
data because the table filter has already excluded Southern data.



 
 

 
 
In summary, view filters supersede all other filters and slicers. Table filters
supersede slicers. Slicers don’t supersede anything.



Advanced Charts
 
Drill down
 
We covered previously how to drill down to lower levels of data in a Matrix
Table. You can do the same thing in a chart. Let’s build a chart with drilldown
capabilities.
 

1. Create a new Power View report.
2. In the field list, click on RegionName, State Name, and then Net

Profit.
3. Click on Table, Matrix.

 

 
 

4. Enable drill down by clicking ‘Rows - Enable Drill Down One Level
at a Time’.

 

 



The table will look like this:
 

 
 

5. Change the table into a chart. Click on Clustered Column Chart.
 

 



 
Since the source Matrix Table had drill down enabled, this feature carries
through into the chart. Double click on a column to drill down to the State
level.
 
For example, I double clicked on Pacific. Now I see data for Utah &
Washington. You drill back up by clicking the upward pointing arrow at the top
of the chart.
 



 
Drill down works for all chart types. Try it out.
 
Optional Exercise
 

1. Change the chart type to Pie.
2. Click on any pie slice to drill down to the State level.

 
Play Axis
 
This feature animates a chart so it shows how data changes over time.
Unfortunately, it does not work for all charts. It works only for scatter and
bubble charts.



 
If you haven’t been exposed to these types of charts, here is what they do and
look like.
 
Scatter Charts
 
Scatter charts show the relationship between two sets of numbers. One
measure is on the x axis and the other is on the y axis.
I created a scatter chart to show the relationship between Net Profit and
Delivery Charge by Product.
 

 
 
Bubble Charts
 
Bubble charts show the relationship between three sets of numbers. One
measure is on the x axis, the second is on the y axis, the third represents the



size of each bubble. In essence, a bubble chart is a scatter chart except that the
scatter chart dots vary in size.
 
Let’s build a bubble chart and then animate it.
 

1. Create a new Power View report.
2. Click on Product.
3. Click on Net Profit.
4. Click on DeliveryCharge.
5. Click on TotalDiscount.

 
You should have a table that looks like this:
 

 
6. Click on Other Chart, Scatter to create a bubble chart (Power View is

smart enough to know that three data points mean a bubble chart and
not a scatter chart).

7. Resize the chart so you can see the data.
 



 
How do you interpret this chart? There’s a lot going on. The image I took had
the mouse pointer over the Lexilam bubble to show you the info box.
 
First, forget about the colors and bubble sizes. Just look at the position of the
bubbles. Net Profit is on the x axis and DeliveryCharge is on the y axis. You
can see the Indigofresh had the highest net profit (because it is on the high end
of the Net Profit axis) and it also had pretty high Delivery Charges (because it
is on the high end of the DeliveryCharge axis).
 
You can see a general pattern that the higher Net Profit items have higher
Delivery Charges. That’s how you interpret a scatter chart.
 
Now look at the size of the bubbles. The bubbles represent the Total Discount.
You can see that Indigofresh and Dingeco seem to have about the same Total
Discount (because their bubbles appear to be about the same size) but Stim
Flex has a much lower Total Discount (because its bubble is definitely
smaller). Softtrax and Lexilam seem to have the lowest Total Discounts (their



bubbles seem to be the smallest of all).
 
That’s how you interpret a bubble chart.
 
Let’s make this chart awesome.
 
How do Net Profit, Delivery Charge and Total Discount vary by Product over
time? In other words, what did this chart look like 3 months ago, 6 months ago,
etc.?
 

8. Drag the MMM-YY field to the Play Axis box.
9. Resize the chart so you can see it better.

 

 
 
The bubble chart now has an additional time axis.
 



 
 

1. Click on the Play button (the triangle next to MMM-YY) to animate
the chart.

 
I know, you’re impressed... :-)
 
This chart shows everything, all the data in the Data Model. That might be
good to illustrate the animation but not really useful for analysis. This is where
filters help a great deal.
 

2. Filter the data so it only shows 2013 data.



3. Drag the Year field to the Filters pane.
 
Year is a numeric field and Power View shows the filter in this format.
 

 
You can certainly use that if you like, but for me, it is easier to select a single
year if I use the List filter format.
 

4. If you want to use the List format, click on the List Filter Mode button.
 

 
5. Select 2013 in the Year filter.

 



 
 

6. Now click the Play button to see the change in 2013.
 
Tile
 
One more thing; I covered this before but I want to repeat it here in case you
forgot. You can create several identical charts and tables by using the Tile By
box. You can’t use it with Play Axis but you can use it with any other
charts/tables. Let’s do a quick review.
 
Using the same bubble chart:
 

7. Remove the field from Play Axis (click on the arrow and select
‘Remove Field’)

 

 
8. Drag RegionName to the Tile By box.

 



 
Now you have created one bubble chart for each Region. Users can click the
tabs to see the different charts.
 

Using Charts as Slicers
 
Previously I covered how to create slicers to let users narrow down data. You
can also use charts themselves as slicers. The only caveat is that to use a
chart as a slicer, the chart must have only one axis.
 

1. Create a new Power View report.
2. Click on ClientName and DeliveryCharge to create this table:

 



 
Now you are going to create a new pie chart.
 

3. Click and drag Product and Cost into the report section to create a
new table.

4. With the new table selected, click on Other Chart, Pie to convert the
table to a pie chart.

5. Resize the pie chart so you can see the slices and product names.
 



 
 
The chart is already set up to be a slicer since it only has one axis. Test it out
by clicking on slice. You will see that the other pie slices are dimmed and the
client table is filtered by product.
 
To cancel the filter, click on the highlighted slice again.
 
This is one feature that probably needs a Text box in your report to instruct
your users of this ability. There is no obvious indication that this ability is
included in the report.
 
Cross Chart Interactions
 
This will make you look like a rock star when you use it in a presentation. Get
ready to hear “wow, whoa!” from the audience. No seriously. It is that cool.
 
Continue working with the current Power View report. You should have a pie
chart (Cost by Product) and a table (ClientName and DeliveryCharge)
 

1. Make sure nothing is being filtered (click on the pie slice to show all
data).

2. Click and drag State Name to the report section.
3. Click on Net Profit.



 
You should have a new table that shows Net Profit by State
 

 
Change this table into a Clustered Column chart:
 

4. With the new table selected, click on Column Chart, Clustered
Column.

 

 
5. Resize the column horizontally so you can see more data.

 
Your report should look something like this.
 



 
 
It doesn’t look like it but all objects are connected to one another.
 

6. Click on a slice in the pie chart.
 
What happened? The Client chart was filtered to show only delivery charges
related to the product selected. The column chart also changed. I clicked on the
Dingeco slice and my column chart looks like this:
 

 
The column chart now shows the Dingeco data in a solid color (because that
was the pie slice I clicked on) and the total bar in a lighter color. The two
colors are a visual representation of the proportion of Dingeco to the total on a
per State basis.
 
Admit it, you’re impressed...



 
I’m going to impress you some more...
 

7. Click on the pie slice you filtered on to clear the filter.
8. Now click on the Utah column in the column chart.

 
The Client table will show only clients in Utah and the pie chart looks all
funky.
 

 
 
The same color logic applies here. The solid colors represent the proportion
of Utah sales by product to the total.
 
Impressive huh? Wait, I’m not done yet. :-)
 

9. Click on the Pie Chart to select it.
10. Click on Qtr-YY and drag it down to the Vertical Multiples box.

 



Now you have multiple filtered pie charts that show per quarter, the proportion
of sales in Utah.
 

 
Please keep this in mind, even though I am showing you each feature one by
one, they do not need to be used in isolation. The previous exercise shows how
you can mix in all the Power View features.
 
Power View is just presenting the data in the Data Model. You can’t break
anything in the data. Mix up all the features, poke around, play with it until you
get the right dashboard or analysis you need. If you mess up a chart, delete it.
Recreate that one again until you get it right.
 
Images
 
Now we are going to review how to add images to Power View reports. One
item to keep in mind is that Power View will only accept two kinds of image
file types: jpeg and png. If you have another file type, you must use Save As
either of these two types in your image processing software.
 
Background Images
 
You can add a background image to your Power View report by clicking the
Set Image button and then browsing to the image you want to use.
 
You can also change the transparency of the image by clicking the



Transparency button.
 
 

 
 
If you have several images in a report, you can have one in front of the other by
right clicking on the image and choosing ‘Bring to Front’ or ‘Send to Back’
 

 
Data Bound Images
 
This is another Power View killer feature. It takes a bit of prep work (nothing
difficult though, don’t panic) but it will add yet another level of ‘wow factor’
to your presentations.
 
Data bound images are images that are imported into the data model itself.
They are stored there and can be used in Power View. In order to get this to
work, you are going to go back into Power Query and work with a new query.
Then you are going to learn how to use these images in slicers, filters and
cards.
 
An Important Note about Images
 



Don’t get in trouble by using images. What I mean is, if you take any image
from the Internet and use it in your presentations, make sure you have the
appropriate rights to it. The image creator can come after you for copyright
infringement. You don’t want that. Of course, if you are using your corporate
images, get clearance from your legal department.
 
For this lesson, I just created some images with the product names in a
different font. Yeah, they are ugly but I want to avoid any legal issues.
 
All right, let’s get started.
 
The first thing you have to do is get the images from your PC into the data
model. You are going to use Power Query for this. You have to use Power
Query. Power View does not change data, it only presents it. Power Pivot does
not change data; it only manages relationships and does calculations. Power
Query does change data and imports it into the data model.
 
Note: I am using Excel 2016. If you are using a different version of Excel
opening Power Query might be a bit different.
 

1. Open Power Query (for me, I click on Data, New Query).
 
You are going to import all the images from the Images folder (these images
were included in the email with the follow-along workbook).
 

2. Click on From File, From Folder.
 



 
 

3. Click Browse and navigate to the Images folder on your PC.
 

 
4. Click OK.
5. Click CTRL and select both the Content and Name fields.

 



 
These are the only two fields that we need. Let’s get rid of the rest of them.
 

6. Right-click on the columns and select ‘Remove Other Columns’.
 

 
Your query should look like this:
 



 
 
The ultimate goal is to use the images to represent a product in the data model.
The only way to do this is to have a related field from the Product table
(already in the data model) to this table.
 
This is the Product table in the data model:
 

 
You need to build a relationship between the ProductID in the Product table to
our Images table. The image names contain the correct ID. You are going to
create a calculated column in Power Query that will extract the ID from the
name.
 
You will need to do something similar for all images you load into Power
Query. You can rename the files with the ID or you can build a lookup table
that has ImageName in one field and ID in the other. Then you can import that
new table and use that as a lookup. The thing you cannot do is type in
numbers (the IDs) directly into Power Query.
 



7. Click on ‘Add Custom Column’ in the ‘Add Column’ tab.
 

 
8. Type in this formula to derive the ID from the name.

 
Text.Range([Name],Text.PositionOf([Name], "_")+1,1)

 
Note: This formula syntax is case sensitive.
 

9. Rename the column ImageID.

 
10. Click OK.

 
Your new query results will look like this:
 



 
Now you need to add an Index column. Honestly, I’m not sure why (since you
aren’t going to use it) but I know if you skip this step the exercise won’t work.
I suspect there is some fancy data stuff going on in the background that requires
this.
 

11. Click on ‘Add Index Column’ in the ‘Add Column’ tab.
 
 

 
12. Choose ‘From 0’ or ‘From 1’. It doesn’t matter which one.

 

 
13. In the Power Query Home tab, select ‘Close & Load To...’

 



 
14. Select ‘Only Create Connection’ and ‘Add this data to the Data

Model’.
 
 

 
The important part is the ‘Add this data to the Data Model’. You don’t really
need to load the data into a worksheet, you just want it in the data model. If you
do load it into the worksheet it’s not a big deal, it’s just an extra worksheet you
don’t need.
 

15. Click Load.
 
Important Note:



 
I think I found a bug. I have a pretty powerful computer and I kept getting an
error saying that there was not enough memory and that I should use 64-bit
Excel. My computer definitely has enough memory for this exercise. I had to
close Excel completely and restart this exercise in order to get ‘Load’ to work.
 
Now you have to change the table properties in Power Pivot.
 

16. In the Power Pivot ribbon, click Manage.
 

 
17. Click on the Images tab.
18. Click on Advanced, Table Behavior.

 

 
 

19. Change the values in the Table Behavior box so they match this image.
 



 
20. Click OK.

 
Now you need to establish a relationship between the newly imported Images
table and the existing Product table.
 

21. Click on the Diagram View tab in the Home ribbon.
 

 
 

22. Click and drag ImageID from the Images table to ProductID in the
Sales Data table.

 



 
23. Close PowerPivot.
24. Save the workbook (I don’t want you losing all this work!).

 
Back to Power View!
 

25. Create a new Power View report.
26. Click on Net Profit then ClientName to create this table:

 

 
Now you are going to add an image-based slicer.



 
27. Click and drag ‘Content’ from the Images table to create a new list.

The list will have the images from the data model.
 

 
28. With the new list selected, click on Design, Slicer.

 

 
Clicking on the different images will filter the data in the other table.
 
Optional
 
You can also use the images as Tiles or Cards.
 



Tiles
 

29. Right click on the Slicer and select Cut to get rid of it.
30. Click any cell inside the table to select it.
31. Click and Drag ‘Content’ from the Images table to the ‘Tile By’ box.

 

 
Now you can use the images to scroll through each tile.
 

 
 
Default Labels
 
Each image in the Tile By box has the file name there. This is because in
PowerPivot, you set the filename as the default label in the Table Behavior
window.
 



 
You can go back to Power Pivot and select a different column as the default
label. If you select [No Column] numbers will appear in the Tile By box. If you
put a blank in a new Power Query column, the tiles show (Blank). I don’t think
you can have an empty Default Label.
 
Potential Uses of this Feature
 
You can have a report that use images of your:
 
•                Products
•                Regions
•                States
•                Employees
•                Salespeople
•                Customer Logos



•                and so on…



Mapping Data
 
You can also use Power View to present geographical data in a map. Maps in
Power View use Bing maps, so you will need to have Internet connectivity if
you want to use this feature.
 
Also, Power View tries its best to determine if a field is geographical or not.
In some cases, you will need to go back into Power Pivot and set the data type
as the appropriate type. This is where you do that in Power Pivot:
 

 
 
Let’s create a simple map showing Net Profit by State.
 

1. Create a new Power View report.
2. Click on Net Profit and State.

 
You will have this table:
 



 
3. With the table selected, click on Map.

 

 
4. Resize the map so you can see the data.

 



 
You can click and drag to move around the map or you can use the control in
the top right to navigate in it.
 



Conclusion
 
So, what did you think about Power View? I think once you get used to new
buttons, you can build some impressive and amazing presentations right in
Excel. No muss, no fuss, and no programming involved. All you need to do is
make sure you have all the data fields and relationships set up in the Data
Model. After that, it’s just a matter of adding fields and filters to build your
presentation.
 
Can you image how impressed people are going to be with the interactive and
animated charts you can build? I think you’re gonna get a promotion out of this!
:-)
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What is Power Map?
 
Microsoft is taking Excel in a new direction. Microsoft has included in Excel
some very powerful tools to help users analyze large volumes of data. This
analysis is usually called Business Intelligence (BI). Previously, processing
and working with these large data sets was limited to experienced technical
professionals that used expensive software packages. Microsoft wants to do
away with that. They want to bring BI to the average user. They use the term
‘Self Service Business Intelligence’ to indicate that users can now perform this
analysis without calling in the IT departments or external consultants.
 
Microsoft’s toolset is called the Excel BI toolkit. It has several different tools:
 

Power Query - Used to import data
PowerPivot - Used to analyze data
Power View - Used to create presentations
Power Map - Used to create geographical presentations

 
This lesson will cover Power Map.
 
Power Map
 
Power Map is a mapping tool that can take data from the Excel Data Model or
directly from a spreadsheet and present it on a map. If you have gone through
the previous lessons on Power View, you might be wondering why Power Map
exists at all since you can add maps in Power View. Power View can add
maps and other visualizations in a report. Power View-based maps also
benefit from the powerful filtering capabilities in Power View. However,
Power Map does have many features that Power View-based maps do not. I
will go through all the Power Map features and by the end of this lesson you’ll
know when you will need to use which mapping utility.
 
 
 



Installing Power Map
 
Excel 2013
 
Power Map comes installed with Office 365 Pro and Excel 2016. For Office
2013, you will need to download and install the Power Map add in.
 
As of this writing, the URL to download Power Map for Excel 2013 is:
 
https://support.office.com/en-us/article/Power-Map-for-Excel-82d65bd7-
70c9-48a3-8356-6b0e82472d74
 
This URL will probably change in the future. To look for the addin, search for
the terms ‘Power Map Excel 2013’ and you should find the correct webpage.
 
The Power Map add-in will work for all the following versions of Excel
2013:
 

Office Professional Plus 2013
Office Standard 2013
Office Home and Student 2013
Office Home and Business 2013
Excel 2013 standalone

 
In Excel 2013, Power Map will look like this:
 

 
 
Excel 2016/Office 365
 
In this version of Excel, Microsoft has renamed Power Map to 3D Maps. The
button is in the Insert ribbon.



 

 
Excel 2013 vs Excel 2016 Differences
 
I’ll start off here by apologizing. The Excel 2016 Power Map interface is
slightly different than the Excel 2013 version. For example, when adding a
new map, Excel 2013 has a three or four step wizard that asks for certain
information. Excel 2016 does not have that interface and instead has one pane
where you make all your choices.
 
I’m using Excel 2016 and I don’t have a copy of Excel 2013 available. If you
are using Excel 2013, some images in the lesson will not match with your
system. I’m sorry for the inconvenience and I totally get that it might frustrate
you not being able to follow the lesson exactly.
 
Rest assured that you can absolutely do everything in Excel 2013 that I am
going to show you, it’s just that you might need to click a few more buttons to
get there.
 
Data Connectivity
 
Power Map uses Bing maps to render its images. To use Power Map, you will
need to allow Excel to connect to the Internet and use Bing Maps. Keep this in
mind when working behind a corporate firewall. If Power Maps does not
display data, you may have to contact your IT department.
 
Data Sources
 
Power Map can use data directly from Excel or from the Excel Data model.
For this lesson Power Map will use data from the Data Model.



 
Region Maps
 
Let’s just start working with Power Map. Not much theory in this lesson. Lots
of hands-on time and you’ll get how the product works pretty easily.
 
Power Map will show data by Country, City or State. Let’s see what that
region maps looks like.
 

1. Open the follow along workbook, PowerMap.xlsx.
2. Click on an empty cell in any worksheet.
3. Click on Insert, 3D Maps (Excel 2013: Insert>Map>Launch Power

Map).
 

 
If you’re using Excel 2013, it will not be 3D Map. Power Map will be here:
 

 
Power Map opens in a new window, outside of Excel.
 

4. Click and drag the Country field from the Field List to the Location
box (Excel 2013: ‘Geography and Map Level’ box).

 



 
There are five types of maps that Power Map supports.
 

Stacked Column
Clustered Column
Bubble
Heat Map
Region

 
You change the map type by clicking these buttons in the Layer pane. The
default map type is a stacked column.
 

 
5. Change the map type from stacked column to region.

 
 

 



6. Click and drag the NetProfit field from the Field List to the Values
box.

 

 
You will see each region’s cumulative Net Profit represented by color.
 

 



If you hover over a data point, you’ll see a pop-up window showing detailed
data on that particular country.
 

 
Let’s add more data to the map.
 

7. Click and drag the ‘Product Category’ field from the field list to the
Category box.

 



 
8. Change the map type to Clustered Column.

 

 



 
Now, this is starting to look pretty cool. You can see column charts for each
country.
 

9. Test out these arrows in the bottom right of the map. They don’t do
what you think they do!

 
 
The up and down arrows change the pitch of the map. The left and right arrows
change the rotation of the map. You can use the + and - to zoom in and out in
the map. You can also use the mouse scroll wheel to zoom.
 

10. Change the chart type to bubble.



 

 
Now you will see a pie chart for every country. Each slice of the pie
represents a product category.
 

 
Note: The reason the bubble chart shows pie charts is because you have a
field in the Category box. If you remove that field, the map will turn into a
bubble chart (with solid color circles representing Net Profit)



Notice that the Layers pane changed a bit when you changed the chart type to
Bubble. The ‘Height’ box now reads ‘Size’. This pane will change based on
the chart type selected.
 
This change is subtle but it does matter? Why size? Size of what? The slices
represent the Product Categories so what does this size attribute do?
 
The Size attribute represents the size of the circle. Larger circles represent a
larger country Net Profit. You can see at a glance which countries had the
greatest Net Profit by comparing pie size. When you find the country of
interest, you can then focus on the pie slices to see the breakdown.
 
Pretty neat. This chart conveys a lot of information with just a few images.
 

Map Properties
 
Let’s work with the map properties to improve it.
 

1. Expand the Layer Options section of the Layer pane.
 



The options here are self-explanatory.
 

2. Use the scrollbar to change the size of the pies so they don’t overlap
in the map.

 
Filters
 
Power Map can also filter that data displayed on the map. Let’s suppose that
you are only interested in seeing data related to products in the Health and
Home category (you need to exclude Electronics).
 

3. Expand the Filters section of the Layers pane.
4. Drag the ‘Product Category’ field from the Field list to the Filters

section.
 



 
The resulting filters section will look very similar to how you filter items in a
Pivot Table or in Power View. If you need more advanced filters, click the
small right-pointing arrow and you will see the advanced filter window.
 

 
Advanced filters work like Autofilters in Excel and in Pivot Tables.
 

5. Click on Health and Home to exclude Electronics.
 



Data Cards
 
Hovering over a data point in Power Map will display a Data Card. You can
customize the information on the data card to show the data you need.
 

6. Hover the mouse pointer over any data point in the map.
 

 
7. Click on the small cog in the upper right corner to open the Card

Editor.
 



 
You can do a lot of stuff here to customize a card. I’m going to list them here
and you can play around with them as much as you want.
 

You can add fields to the card (and not add them to the map) by clicking
the ‘Add Field’ button
Click and drag the fields to change their order
Change the field name by clicking the pencil icon
Change the field aggregation method by clicking Sigma

 

 
Remove a field by clicking the x.
Apply a pre-defined template by clicking the right and left arrows.

 

 
If you completely mess up the card appearance, click the ‘Reset to Defaults’
button to undo all your changes and start over.
 

8. Add the stdCost and stdPrice to the Data Card.
 



 
Note: The current version of Power Map does not have the ability to apply
custom formatting to the value fields. I’m hoping this feature will be
incorporated soon.



Layers
 
You have been working in the Layer pane all along. What exactly is a layer?
Each map and its customizations are stored in a layer. You can add new layers
to superimpose maps on one another.
 

1. Click on the pencil icon to rename the layer to Net Profit.
 

 
Notice that you can also hide layers by clicking the eye icon.
 

2. Click the ‘Add Layer’ button (this might be different for you if you are
using Excel 2013).

 

 
3. Rename the new layer Units Sold.
4. Drag the Country field to the Location box.
5. Drag the UnitsSold field to the Height box.

 
You will now have a column chart combined with the previous pie charts. It
doesn’t look that great.
 



 
 

6. Change the map type to Region.
 

 
Now the maps look a bit better. You can still see all the following:
 

NetProfit per country (based on the size of each pie)
Breakdown of Health and Home (based on each pie slice)
Total Units Sold (based on the shade of the country color)

 



 
Important Note:
 
The filter you applied in the Net Profit layer is applied to this new layer.
Notice how Electronics is not shown in the map.
 
 
 
Mapping Confidence
 
Power Map can use latitude, longitude, zip codes, country names, city names
and even custom names to show geographic data. You need to be careful with
data that is not precise. For example, suppose you have a date set that has
Paris. Power Map will not know if you mean Paris, Texas or Paris, France. In
this case, you will need to add another field to further define the geographical
data. In this case, you can add a State or Country field and then add it to the
Location box.



 
Power Map lets you know where it ran into trouble. As you work through the
lesson you can see how confident Power Map is on its mapping guesses.
 

 
Clicking on the percentage will open the Confidence Report.
 

If 96% accuracy is good enough, then you don’t have to worry about the 4%
errors. However, if you need greater accuracy, then you need to use this report
as a starting point.
 
The red x’s mean Bing maps doesn’t have shape icons for these countries. You
can’t fix this directly in Power Map. You will need to go into the source data
and try another name, add a longitude and latitude or add a zip code to see if
Bing can retrieve the right country shape (if it has it available).
 
The Yellow warning icons indicate that Bing took its best guess. The data had



‘East Timor’ and Bing chose ‘Timor-Leste’.
2D Charts
 
Sometimes a geographical map can be enhanced by a standard chart. For
example, consider trying to look for the country with the highest number of
units sold. You would have to move along the world map looking for the
country. In these cases, using a 2D map will make searching (and visualizing
data) easier.
 
Let’s add a 2D map to the Units Sold layer. (Hint: It’s pretty easy).
 

1. Click on the 2D Chart map in the Power Map ribbon.
 

 
2. Chose Units Sold as the layer to apply the chart to.

 

3. Click Insert.
4. Drag the chart to one corner of the map.

 



 

 
This map has a few useful features.
 

You can change the map type by clicking on the map button in the top
right of the map (you have to have the mouse pointer over the map for it
to appear)
You can see the Bottom 100 locations by clicking the ‘Top 100
Locations’ title
If the map had multiple values, you could select another one by clicking
‘UnitsSold (Sum)’
Hovering over a column displays that country’s data card

 
And this is the great one:

Clicking on a column will highlight that country and move the map to that
region

 



 
Timelines
 
Timelines are great! Wait until you see them in action. Timelines let you
leverage agile frameworks to provide a robust synopsis for high level
overviews. They facilitate iterative approaches to corporate strategy to foster
collaborative thinking and to further the overall value proposition. They
organically grow the holistic world view of disruptive innovation via
workplace diversity and empowerment.
 
You will learn to bring to the table win-win survival strategies to ensure
proactive domination. At the end of the day, going forward, a new normal that
has evolved from generation X is on the runway heading towards a streamlined
cloud solution. User-generated content in real-time will have multiple
touchpoints for offshoring.
 



Awesome right?
 
HAHAHAHAHAHAHAHA!
 
I’m just messin’ with ya. That was a bunch of corporate nonsense I put in there
to see if you were paying attention.
 

 
Back to timelines.
 
Power Map can display data as it changes over time. All you need is a field
with a time measure in it.
 
Let’s add a brand new map to the workbook.
 

1. In Power Map, click on File, Close. You won’t lose the current map; it
will be included in the Excel file.

 
Look at the data in Excel. Excel put a handy message box letting you know
there is a map of the data.
 

 
Tours is what Power Map calls each map.
 

2. Click on 3D Maps to add a new map. You’ll see a new window
appear.

 



 
 

3. Click on ‘New Tour’ to create a new map.
4. Drag the Country field to the Location box.
5. Drag the UnitsSold field to the Height box.
6. Drag the NetProfit field to the Height box.
7. Change the chart type to clustered column.
8. Drag the DateSold-MDDYYYY field to the Time box.

 
 



 
Two things were added to Power Map. A box (at the top left of the map)
showing the date of the data shown; this box is called the time decorator.
 



 
 
A timeline has been added to the bottom of the map.
 

 
9. Click the Play button to see how data changes over time.

 
You can zoom is and move around the map while the animation plays.
 
Timeline Options
 
You can change how the timeline behaves by changing its properties.
 

10. Click on the gear icon on the timeline.
 

 



Here you can name the scene, add effects and set a time filter so the scene only
animates data within the specified date/time range.
 
Power Map Movies
 
You can combine multiple scenes into a movie. You can then compile these
movies into files that can be sent to users. They can watch the movie without
having to use Excel.
 
Let’s build a movie using the last exercise that had a chart with the timeline
added.
 

1. Add a new scene by clicking the ‘New Scene’ button (2013: ‘Add
Scene’ button).

 



 
2. Select Copy Scene 1.

 

 
 

3. Zoom into Europe.
4. Change the map to Bubble.
5. Delete NetProfit from the Size box.
6. Drag ProductCategory to the Category box.
7. Click on Scene Options in the ribbon.
8. Change the effect to Push In.

 



 
9. Click on Play Tour in the Power Map ribbon.

 

 
Create Video
 
Creating a video is a matter of a few clicks.
 

1. Click Create Video in the ribbon.



2. Choose the output quality.
 

 
3. Load the recorded soundtrack (if you have any).
4. Click on Create.
5. Choose a location to save the movie.

 

 
That’s all there is to making movies.
 
Custom Maps
 
You can extend Power Map’s functionality by using custom maps. These maps
don’t even have to be geographic. Suppose you have a picture of a widget your



company produces. You also have a data set from the Engineering department
that shows where the major failure points were in testing. You can use Power
Map to show that data graphically.
 
Let’s see how that works. I’ll supply the product image and you’ll make up the
data.
 

1. Open a new Excel workbook.
2. Create a spreadsheet like this one.

 

 
 
Now we need to create data that is correlated to the image. You are going to
record the x and y coordinates of the failure points.
 

3. Open widget.jpg in Microsoft Paint (This file came along with the
Excel workbooks).

4. Hover your mouse icon over any spot on the widget. Paint will how
you the x and y coordinates in the bottom left of the window.

 



5. Record the coordinates in Excel.
 

 
 

6. Repeat choosing coordinates until all 10 rows are filled.
 
This is what mine looks like. Yours will be completely different. That’s ok.
 



 
7. Close Paint.
8. Click on any cell in the sample data.
9. After launching Power Maps, click on 3D Maps to insert a new map.

10. Click on New Scene, New Custom Map.
 

 
11. Click on ‘Browse for the background picture’.

 



 
12. Navigate to widget.jpg and click Open.
13. Use the Tilt and Rotate buttons (in the bottom right of Power Map) to

position the image.
 

 
14. Click on the ‘Pixel Space’ button.

 



 
 

15. Click Done.
16. Drag the x and y fields to the Location box.

 
A new drop down with the words ‘Select One...’ will appear. You need to tell
Power Map what these fields are.
 



 
17. Set x as the X Coordinate and y as the Y Coordinate.
18. Drag the field ‘Times failed’ to the Height box.
19. You’ll get a bar chart for each failure point. For this exercise, that’s

not the best visualization.
20. Change the chart type to Heat Map.

 

 
 
 



 
 
This is a better visualization. Now you can see where the product has had the
most problems.
 
Your use of Power Map is really just limited to your imagination and the
availability of data. With these custom maps you can track all kinds of stuff.
Here are a few examples I can think of:
 

With a web page as a map, you can track where people click the most
Using a warehouse floor plan and accident data, you can see where the
most accidents happen
Track throughput on an assembly line

 
OK, we’re done! Cool stuff huh?
 
You’ve learned all the complex parts of Power Map. I didn’t cover some items



because I am certain you can figure them out; adding text boxes, changing the
background, using themes, etc.
 
One last thing, I used countries in this lesson. You can get much more granular
than this. Power Maps will interpret countries, zip codes, latitude and
longitude values, even street addresses. If you have that level of detail, try it
out.
 
Go forth and amaze your coworkers!



Other Lessons
 
I have many other lessons covering various Excel topics.
 
You can find all of them on my website at: http://markmoorebooks.com/excel-
lessons/
 
If this lesson has helped you, please take a few minutes and leave a review on
Amazon. The more reviews the lesson gets, the easier other students will be
able to find it.
 
Thank you!
 

http://markmoorebooks.com/excel-lessons/
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